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User Interface & Visual Design
Jennifer Haugsjaahabink

Purpose
Yogi Berra once said, “If you don't know where you are going, you'll
end up someplace else.” Before you start designing your educational
website, it is important to identify the purpose of your site so that you
know exactly where you are going to end up in terms of the finished
product. To help you identify the purpose of your site, consider two
things: 1) Who are you expecting to visit your site? (e.g.,
Students? Parents? Administrators? Colleagues? Your professional
learning network?) and 2) What do you want your audience to be
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able to do on your website? (e.g., Access class assignments? View
student work? Learn about your teaching practice?)
Designing an educational website is much different than other types
of website development. You are not trying to get users to buy your
product. Instead, your target audience is coming to your website for a
reason - what is that reason? You may be setting up a site for your
students to keep track of what is going on day-to-day in the classroom
or for students to find online resources and activities that extend
learning related to class topics. Your website may end up serving
several different purposes, but starting with just one can help simplify
the initial design process. Whatever the purpose of your website is,
keep that purpose in mind at all times and continually check that you
are meeting your goal.

Figure 1: Mindmap of different reasons to create an educational website (created using Mindmup).
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Planning
Building a website without some degree of planning can lead to
frustration. If you don’t have a plan, you may waste a lot of your time
setting up your page with images, content, and menus only to find out
that you need to start over because the setup does not satisfy the
main purpose of the site. To reduce potential frustration, start your
web design process with researching and sketching. For research,
explore various websites, including ones that are similar to what you’ll
be producing. Look for sites that have a similar purpose as yours and
identify sites that you found easy to use or particularly memorable. Jot
down highlights from those sites that you could incorporate into your
site design. You don't have to include everything at first. Just keep
notes about what you liked and you can add features in over time.

Figure 2: Using GoogleDocs to take notes on Likes & Dislikes of different websites.

Next, sketch out your website organization and visual design. Take a
piece of paper and a pencil (several Post-Its work, too) and sketch the
layout and content for each page. It is a lot easier in the beginning to
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rearrange post-it notes or switch around your layout on paper.

Figure 3: Use paper and pen to experiment with different layout options.

Visual Organization
Layout
The layout of a website defines the location of typical items on a
website, including the menu, the banner or logo, the navigation bar,
contact information, and social network icons The layout involves
decisions about the position of each item on the page, the size of
images and text, and placement of visuals. If you were to look at
popular websites (e.g., Google, Amazon, and National Geographic) you
would find these typical items in similar locations. On many
websites, the menu, navigation bar, and logo are found near the top of
the page. Contact information and social media icons can be found at
the bottom of the page or sometimes in the upper right corner of
websites.
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Figure 4: Screenshot of the top of National Geographic’s homepage, noting location of logo, menus and navigation
bar.

Figure 5: Screenshot of the bottom of National Geographic’s homepage, noting location of contact information and
social media icons.

Your visitors are most likely well-versed with website layout without
even knowing it. They will look to the same place for the items they
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need to move around your website. For example, on most websites,
when you click the header, you will be taken back to the home page.
Keeping with this tradition on your site will ease user navigation. The
graph below depicts the typical placement of common website
elements:

Figure 6: Chart illustrating the percentage of time the placement of key web design features are in a particular
location. Figure adapted from Crestodina (n.d.) 27 Research-Backed Web Design Tips: How to Design a Website That
Works.

Consistency
Your website should have a layout that is consistent from page to page
(e.g., the menu, header, and search engine can be found in the same
spot on every page of the website). This can make navigation easier
for the user, as they will know where to look or click to move
seamlessly throughout the site.
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Figure 7: Pages within National Geographic’s website, noting consistency in the placement of web design elements
like logo, navigation bar and menus.

Above the Fold
When deciding on the layout of your site, consider what information
or visuals will be “above the fold.” This term originated from the
design of newspapers - with only the upper half of the front page of a
newspaper (the part above the fold) being visible to passersby, editors
placed the most important and captivating information there to
attract attention and increase readership. This concept applies to
web design, but rather than a physical “fold,” you have the bottom of
the screen. Anything that requires scrolling is below the fold. Since
people spend only a few seconds deciding whether to stay on a
website, you need to capture their attention and present the most
relevant and interesting information “above the fold” on every page.
You could do this by placing a short video at the top of the page, an
attention-grabbing heading, or intriguing visuals or text. Keep in mind
that the “fold” will be different depending on what device your visitor
is using (see Figure 8). You need to be aware of the fold and design
your page so that your most important content lies above the fold (to
learn more, explore the Above the Fold vs. Below the Fold article).
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Figure 8: Your home page will look different on different devices - phone, tablet, laptop and desktop. The fold also
changes with each device type. Vector Designed By cornecoba from PNGTree.

Navigation
When designing the navigation for your site, keep in mind your
website’s purpose and make sure that you are using the simplest and
clearest method of navigation to accomplish that goal. You will begin
the design of your website with your home page - your main page - the
page your users will see first. This page may not be able to accomplish
everything. Your visitors may need to navigate somewhere else to find
what they need. If a visitor is unable to find what they need in an easy
way, they will become frustrated and may not use your website (or
curse it everytime they do). When someone wants to find something in
a book, they look to the table of contents. On a website, navigation is
basically your table of contents. How can you help your visitors
find what they are looking for? The main technique used in all
navigation schemes is menus. It is important that they are wellorganized, easy to use, and easy to find (remember, the table of
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contents is always in the front of the book!). Also, keep in mind the
concept of “serial position effect.” That is, most visitors will look at
the first and last items in a list. So make sure the most important
items needed to achieve your purpose are at the top of any menu list.

Figure 9: Video from using the Common Sense Media website to demonstrate scrolling, tabs and drop-down menu
navigation

Search engines are also a popular navigation tool. Most web design
tools, like Wordpress, allow you to embed a search engine within your
site. If you opt to do this, make sure the search engine shows up on
every page (consistency of layout) and that your pages consist of text
(and images with alternative text descriptions) featuring key terms
users would search for. For example, if a student visited your site and
used the search engine to find “homework,” but your homework page
is titled “after-school work” then the search engine would not be a
helpful navigation tool.
Another type of navigation is within-page linking. If you have a long
page of text or images, it can be beneficial to break up the content by
headings and place a table of contents at the top of the page that
The EdTech Books User Guide
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users can click on to go to specific sections (rather than having to
scroll through the entire page). If you setup your website like this,
make sure there’s a “back to top” link at the bottom of each section so
users can always get back to the table of contents and menu.
One other navigation method worth noting is the use of accordions.
This method allows the user to view many heading at once and open
as many sections as they want.

Figure 10: Video using the Royal Society of Chemistry website to demonstrate accordion navigationCaption

Navigation Tip: If you have your users navigate to an external site,
make sure to have it open in a new window or tab so that they can
always get back to your website.

Visual Design
Visual design covers a lot of territory. Often people hire graphic
designers or professional website developers to create visually
appealing website designs. Don’t worry! Just like all the other pieces
of your website, you can do this too. Remember to keep it simple. You
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can always go back and add complexity. The main purpose of your
website shouldn’t be lost among cool visual effects. Your visual design
should not confuse your visitors while they try to navigate your
website. In fact, the visual elements should help lead the user to
the key items on your website. This is often referred to as visual
hierarchy. Web design sites like Google Sites, Wix, Weebly and
Wordpress take care of some of the visual design decisions by offering
simple templates.
Some basic visual design elements are highlighted on this popular
website:

Figure 11: Screenshot of Common Sense Media homepage highlighting different visual design elements.

Guidelines for typical visual design elements:

Text
With text, make sure that it is easy to read. Most browsers default to a
16-point font size to ensure readability and accessibility. You should
use that as a guideline and make sure you don’t go any smaller. Use
larger text size for titles, headings, and subheadings, so that they
stand out from the body of content. Even though it is tempting to use
interesting fonts, remember that your website needs to be readable! It
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is good practice to limit yourself to no more than 3 fonts and
maintain consistency in font style from page to page.

Color & Contrast
It may be tempting to use lots of color on your website, however too
many colors can be overwhelming and distracting. Use colors to
guide your visitor’s eyes to the most important parts of your page.
Whatever color palette you choose, whether it is black and white or
cool blue tones, use the same colors throughout your website. A
helpful color palette generator for websites can be found at Palletton.
In terms of accessibility and readability, make sure that color isn’t the
only thing used to signal important information (e.g., use bold, bigger
font size, or italics) and ensure that the colors you select provide
enough contrast so that the text is easy to read. Use the WebAIM
Color Contrast Checker to test the contrast of the colors of your
fonts and background.

White Space
It is not necessary (or recommended) to fill every square inch on a
page. Use white space on your page to reduce visual clutter, make
the visual path clear to your user and allow them to find what they are
looking for efficiently.

Icons
Use standard icons and shapes on your website. For example, “help”
is understood to be represented by a question mark and “home” is
often depicted by an image of a house. The Creative Commons
website features a list of free (with attribution) icons you can use on
your site.
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Accessibility
Educational websites are for everyone! Some of your users may have
disabilities and your website needs to allow them to access the
information you have presented. A recent study of more than 6,000
school and district websites found that the vast majority failed to be
fully accessible (Accessibility in Mind? A Nationwide Study of K-12
Web Sites in the United States). Use the Accessibility Statement
Generator tool to ensure your website is accessible and to put a
statement on your site showcasing that you value accessibility. Also,
for more information see Chapter 5: Digital Accessibility.

Figure 12: Image of disability symbols - websites must serve and accommodate all people.
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Adaptability
Your visitors may be accessing your site using a desktop, laptop,
tablet or mobile device. It is crucial that your site work on all of the
above. The purpose of your website cannot be lost or inhibited
because of different screen sizes. Some of the free website building
programs (Wix, Wordpress, Google Sites) incorporate a design or
template that is responsive to any device. When thinking about a
mobile device, make sure that the text remains legible, your most
important information lies above the fold, and that buttons are not too
small to be pressed by an average fingertip. Also, make sure to test
your website across multiple devices and browsers. The big 5
browsers are: Chrome, Edge, Firefox, Opera and Safari (“How to
Design a Website”, 2017). You must test every path, link, and button
for correct function.
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Figure 13: Be sure to test that your website responds predictably on all types of devices.

User Interface & Visual Design Checklist
Declare target audience of website
Narrow down main purpose of website
Research other websites
Sketch out website design
Build website layout
Establish clear and easy navigation
Main purpose remains clear
Utilize simple visual design
Make sure to address accessibility
Test website on different devices
Test website on 5 different browsers
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Test all links, buttons and navigation path
Fix any issues
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Writing For The Web
Torrey Trust

Introduction
The use of websites as educational tools provides a unique way for
students to access material in a variety of different formats. However,
while educational websites may increase access to information, they
also present their own challenges. Research suggests that only 16%
of people read webpages word-for-word. Most people scan
(Nielson, 1997). Additionally, people often spend only a few seconds
exploring a site before determining whether to stay or leave. And,
with the distracting world of the Internet, where a funny cat video is
only a click away, it is even more challenging to maintain readers’
attention on a website.
When you are writing for the web, you must create content that is
captivating, engaging, and informative while also being easy to scan.
This means writing for the web looks very different than writing for
print. Check out our chapter overview video to see an example of how
to transform a traditional print paragraph into text that is easy to read
on a website.
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Watch on YouTube https://edtechbooks.org/-uTd

This chapter will showcase the tricks you need to write web content to
capture and maintain the attention of your readers. We will begin by
discussing how to use formatting techniques (e.g., whitespace, bold,
italics, bullet points, headings, and font size) to facilitate quick
reading and to draw the attention of the reader to key information.
Then, we will cover how to use language in a way that appeals to your
audience. Finally, we will showcase tips for writing subject specific
content to engage learners.

Formatting
The way you organize and format a website is the first thing visitors
will notice. It’s essential to design your website to be easy on the
eyes. Websites that have a lot going on (often referred to as “busy”)
are difficult to gather information from and can turn people away
from your page. If viewers are overwhelmed and can’t figure out what
to focus on, how to find information, or where to go on the site, they
will make an immediate exit. The following section offers tips and
ideas to improve how your website is read by visitors.
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White Space
One way to avoid making your website look busy is by utilizing white
space. White space is the unfilled space on your website. Keeping
some space free of images or text helps to break up your page to
make it less cluttered.
In the example below, the Lings Cars site fails to utilize white space
as a means of breaking up the content for two reasons. First off, there
is very little background space - most of the website has words,
pictures, or menus on it. The remaining background has a complex
pattern that is jarring to the eyes. This combination creates a website
that is difficult to look at for more than a few seconds, which is not
ideal when you want visitors to stay on your webpage.

In contrast, the Pisaccochronicle site featured below uses a lot of
white space, which makes it easy to quickly scan. By minimizing
content and maximizing white space, readers have only a few options
(read, move to the previous or next page, or explore the menu).
Rather than feeling overwhelmed, viewers are encouraged to read,
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scroll, and explore.

Breaking Up Text
Not every website has to be as simple and limited in text as The
Pisacco Chronicle. Your website can include paragraphs of text.
However, if you are planning to write a lot of text on a webpage, one
way to make it easy to read is to break up the text into smaller
paragraphs. Take a look at popular news sites, like the New York
Times or Dallas News, which are known for producing long articles of
text, and you’ll see that most often paragraphs are 2-3 sentences with
white space or visuals in between. Another popular technique is bullet
points. Using bullet points with short sentences:
Breaks up paragraphs of text.
Makes it easy to scan.
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Creates white space.
Take a step back and look at this paragraph again...what captures
your attention? The bullet points stand out because they create a
break in the text and are easy to quickly scan.
Accessibility tip: If you use bullet points, make sure to put a period at
the end of each point. This allows screen readers to know that the
sentence has ended.

Typographical Emphasis
Remember: “People rarely read Web pages word by word; instead,
they scan the page, picking out individual words and sentences”
(Nielson, 1997, para. 1). Since readers tend to scan webpages or skim
right over large chunks of text, you can use typographical emphasis,
such as bold, italics, font color, style, and size, to direct their
attention to the most important information. Take a step back and
look at this paragraph - what is the first word to capture your
attention? Likely one of the bolded words since those stand out in
contrast to the rest of the words. Italics can be used to capture
attention, but not in the dominant way of bolding. Use bold to draw
attention to the most important words and phrases and italics to
make any additional information standout.
Changing the font color will also draw attention, but be wary of using
color only to highlight key information as that may leave out
individuals who are colorblind or visually impaired. While shifting the
font style and size are other ways to emphasize text, limit your use of
this technique. The more you change style and size, the more
overwhelming the text becomes to read.

Inverted Pyramid
Using the “inverted pyramid” concept is another technique to
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captivate and capture the attention of website visitors.

The idea behind the inverted pyramid is to have the most important
information “on top” (within your first paragraph), with the details
coming in the subsequent paragraphs. Readers often scan pages for
information, so by putting the big takeaways early on, you will
increase the chances the readers learn the information they need.

Subheadings
Subheadings give the reader a roadmap of your website and are
critical for accessibility and screen readers. Using subheadings
helps chunk, or compartmentalize, ideas and concepts, while
also reinforcing the hierarchy of information. For example, if you
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have a website heading for “atoms,” and subheadings for “protons,”
“neutrons,” and “electrons,” the subheadings reinforce that they are
the parts of an atom. It’s important to consider the size of font when
making headings, below is the best way to determine it:
Heading One (H1): The main heading at the top of the page,
should be the largest font
Heading Two (H2): The heading used to separate the content
within your main heading, should be larger than your text font,
but smaller than H1
Heading Three (H3): The heading used to make small
points/asides, may be the same size as your text font, but
bolded or italicized to differentiate from the text
It is worth noting that certain web design platforms (such as Wix,
Weebly and Google Sites) automatically set the page title to Heading
1, but you will want to check the settings to confirm this. These
platforms often also set the size and style of the headings, so all you
need to do is use them!

Language Usage
The most important thing to remember is that writing for the web is
different than academic or print writing. You should be using “half the
word count (or less) than conventional writing” (Nielson, 1997, para.
3) on a webpage. With less words to communicate the information you
want to present on your website, you need to ensure that every
word that you use, the tone that you take, and the style of
writing you employ increase the readability of your page.
Ultimately, the language you choose to use can influence whether a
reader explores the content on your site or makes an immediate exit.
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Know Your Audience
According to the University of Maryland Baltimore Website Manual
(n.d.), “Most users visit a web page for 10-15 seconds. In that brief
time, 80 percent will skim the page for keywords they already have in
mind. Therefore, before you create content, it’s important to
understand your audience and anticipate what content and keywords
they’re trying to find” (para. 27).
Are you creating a website for your students? Parents? Colleagues?
Administrators? Which words or phrases appeals to each of these
groups? What type of tone and language do you use when
communicating with each of these groups? You will want to keep this
in mind when selecting the word choice and writing style for your
website.
Use language that appeals to your audience. For example, if you
are designing a website for your students, consider what language
you use to capture their attention or give directions, and use this
same style of language when creating your website content. Also, use
a readability checker to ensure your content is written at a level that
is accessible by your audience. By paying close attention to your
language usage when designing your website and ensuring it will
captivate your audience, you will keep them engaged in your content
for longer.

Readability
The majority of Americans read between a sixth and ninth grade level
(although your students might be even lower than this). Writing
content that is too advanced or takes too long to understand will
discourage visitors from exploring your website. Using plain
language that is simple, concise, and concrete “removes
barriers between you and your readers” (Loranger, 2017, para.
4).
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While you may be thinking that using plain language will dumb down
the content or lower student achievement, this doesn’t have to be the
case. You can still present the information on your site in a
professional manner, while also ensuring it’s easy to read or scan.
Indeed, using plain language is “welcome by readers; in fact, studies
show that it makes the writer look smarter. (If people understand
more of what you’re saying, they will likely feel that you make sense.)”
(Loranger, 2017, para. 4).
While academic literature is made of long complex sentences and
highly specialized vocabulary, studies show that professionals
today value content that is “clear and concise” (Loranger, 2017).
Modeling this type of language on your website will make it easier for
students to access and understand the content.
Word Choice: Keep your vocabulary simple and make your
points as plainly as possible. Prioritize nouns and verbs - use
adjectives and adverbs only when necessary. Get rid of
unnecessary words (once you have written your content, read it
again and see how many words you can delete, then repeat this
process).
Sentences: Your sentences should be short and to the point.
Avoid complex sentences. If you need to break up a sentence, a
dash is the most effective way to do it. But, it is best to split the
sentence in two.
Paragraphs: Paragraphs should be no longer than five
sentences long and should only address the specific heading
they are connected to. Any information that strays from the
topic will confuse the readers trying to move quickly through
your page.
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Tone
Establishing a rapport with your learners can lead to good learning
outcomes. The same is true online. The tone that you take in your
writing for the web will determine how your students “hear” you.
Keep this in mind and follow these guidelines to establish an
appropriate tone:
Choose a tone that mirrors how you interact with learners in
real life.
Establish a tone that is consistent and appropriate for both age
and context.
Don’t be too rigid. This can be off-putting and offensive
(University of Maryland Baltimore, n.d.).
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When it comes to tone, value brevity over voice and stay
consistent.
Write in an active voice and maintain a uniform verb tense
throughout your work.

Credibility
As your students scroll through your educational website, they will be
evaluating the trustworthiness of your information. The last thing you
want is your students questioning whether the content you provide is
accurate. The best way to avoid this is simple: Make sure your writing
is comprehensive, correct, and current. Use a spell checker! When
readers find spelling or grammatical errors on a website, they’re less
likely to trust the content. Connect your content to the rest of the
internet using links, multimedia, and other resources.
Cite all of your sources - this is not only essential for legal reasons,
it’s also an important technique to role model for students. You can
decide what type of citation style to use (e.g., MLA, APA, Chicago),
just make sure to keep it consistent throughout your entire site. Use
quotation marks to indicate any information directly pulled from
another source, such as a website, blog, book, or video. Simply
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providing a link to an article without identifying the author (e.g.,
source) is not enough to cite borrowed information.

How to Write in Plain Language for Teaching
In this article, Bendici (2021) shares that it can be helpful to:
Avoid acronyms.
Avoid passive voice.
Aim for a 8th-9th grade reading level.
Be clear and concise (re-read your text and remove as many
words as you can).
Include relative pronouns (whom, who, which).
Not use different words for the same subject.

Writing for a Subject-Specific Website
If you are designing a website to present your students with
information and resources related to one or more subject areas, here
are a few additional tips to engage your learners with the text on your
site.
Keep it Simple and Organized: Limit the amount of information on
your website so that your students don’t feel overwhelmed when they
visit. Chunk information and resources for sub-topics into separate
sub-pages rather trying to feature everything the student needs to
learn about a topic on a single page.
Keep Your Content Up To Date: Have you ever scrolled to the
bottom of a website to see its copyright date (e.g., Copyright 2013)
and then question the credibility of the information on the site since it
hasn’t been updated in many years? Your students will do the same
thing! Make sure you spend time at least once every few months
modifying your site by revising information, adding or removing
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resources, and featuring related news. By presenting new content for
your subject area, you can hook students in and have them stay on
your site longer. For example, if you’re designing a social studies
website, instead of presenting the same facts about American
historical figures, you can add content that usually gets skipped over
or left out of history textbooks such as LGBTQ history and notable
African-American history. By incorporating interesting new content
that appeals to your students, you will be increasing student
motivation and engagement.
Create Content that is “Made To Stick”: Heath and Heath (2007)
developed a set of guiding principles, called the Made to Stick
principles, that can be used to create content that is “sticky,” (i.e.,
hard to forget). The acronym SUCCESS can help you remember the
principles:
Simple: As mentioned previously, don’t overwhelm the reader.
Focus on one key point per paragraph. Omit extra words. Write
in a concise and clear manner.
Unexpected: Present information that surprises the reader.
Concrete: Make it easy for the reader to see how the content is
relevant to their life.
Credible: Ensure the information you present is current,
accurate, and reliable.
Emotion: Present content in a way that make the readers feel
something (e.g., joy, frustration, anger, excitement).
Story: Tell a story. Storytelling is one of the most powerful
techniques for communicating information since people who
are reading or listening to a story mentally put themselves in
the story, thus making it more memorable.
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Chapter Conclusion
If you follow the tips from this chapter, you will be able to fill your
website with content that your readers will find engaging, interactive,
and memorable. Here is a checklist to help you remember the key
points from this chapter:
Keep your website simple - use white space and plain
language.
Break up large chunks of text.
Use typographical emphasis (e.g., bold, italics, font size/color)
to draw readers’ attention to specific words or phrases.
Put the most important information at the top of the page
(inverted pyramid).
Use subheadings and sub-pages to chunk and organize
information.
Use language that appeals to your audience.
Ensure your content is current, credible, and accurate.
Keep your content up-to-date.
Employ the Made to Stick principles to engage your website
readers.

References
Loranger, H. (2017, October 8). Plain language is for everyone, even
experts. Nielsen Norman Group. Retrieved from
https://edtechbooks.org/-Kbw
Nielson, Jakob. (1997, October 1). How users read on the web.
Nielsen Norman Group. Retrieved from
www.nngroup.com/articles/how-users-read-on-the-web/.
University of Maryland Baltimore. (n.d.). Best practices for web
writing. Retrieved from https://edtechbooks.org/-Gag

The EdTech Books User Guide

36

Copyright and Open Licensing

Learning Objectives
Understand concepts of copyright, public domain, fair use, and
open licensing;
Find open educational resources (OER) online;
Recognize how to cite and share OER.
Copyright is established in federal law and varies from country to
country. In the U.S., copyright was written into the original
constitution in 1787, wherein it was stated that copyright is
established "to promote the progress of science and useful arts, by
securing for limited times to authors and inventors the exclusive right
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to their respective writings and discoveries" (Article 1.8.8). Thus, at
its foundation, copyright in the U.S. exists "to promote the progress of
science and useful arts," and authors are given control of their
creative works for a specified period of time so that they can profit
from them, thereby encouraging them to create more.

Watch on YouTube https://edtechbooks.org/-gr

What do you think?
How do you think copyright considerations will affect or has
affected your teaching?
a. I will often be afraid to use valuable resources
b. I will sometimes be afraid to use valuable resources
c. I will never be afraid to use valuable resources

Key Terms
Copyleft
an alternative to copyright that allows one's work to be copied,
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shared, or remixed (e.g., Creative Commons)
Copyright
legal protections for authors of creative works (e.g., books,
movies, lesson plans) that prevent them from being used by
others without permission
Fair Use
the limited ability to use copyrighted works without permission
as determined by four factors (Nature of Use, Type of Work,
Amount Used, and Commercial Impact)
Open
in the context of openly licensed materials or open educational
resources (OER), this means gratis and libre; gratis means that
content and resources are provided at no cost, while libre
means that people are free to do what they want with these
resources
Open Licenses
an license that allows users to freely use a resource without
seeking permission (e.g., public domain, Creative Commons)
Public Domain
in the US, a technical term referring to works that are not
subject to copyright protection, such as very old works
Royalty Free
a variation of copyright that allows materials to be used in
some limited manner (e.g., print an image up to ten times)
without paying a fee
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Types of Works
Copyright applies to any tangible or electronic creative work, such as
a book, movie, video, song, lyrics, poem, picture, lesson plan, web
page content, etc. Any creative work is copyrighted as soon as it is
created. Intangibles, such as ideas, concepts, and mathematical
equations and works that lack originality cannot be copyrighted.

Gaining Copyright
Since copyright applies as soon as a work is created, authors do not
need to go through any process to copyright their works. They are
copyrighted automatically. However, proving that you hold the
copyright on your creative work is another matter. For instance, say
that you write a novel and lend the manuscript to your neighbor to
proofread. What is to prevent your neighbor from claiming that the
novel is her creative work and, therefore, claiming to hold its
copyright? To help in preventing and addressing copyright problems,
the U.S. government allows copyright holders to register copyright
with the U.S. copyright office [http://www.copyright.gov/]. Thus, while
an author does not need to do anything to copyright a work, they do
need to go through a process if they would like to register the
copyright of that work to safeguard against infringement.

The Copyright Symbol
The copyright symbol may be placed on a work to remind and inform
users of its copyright status: ©. However, the copyright symbol is only
a reminder. The absence of the symbol does not mean that the work is
not copyrighted, and the presence of the symbol is not proof that the
work is copyrighted (as will be discussed further in the case of public
domain works).
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Ownership
By default, the author of a work holds the copyright on that work. The
main exception to this rule would be if the author was being paid by
someone else to create the work and the author had signed a contract
stating that work created while on-the-job belongs to the employer
commonly known as "work for hire". Contracts might also stipulate
that this depends upon when and where the work was created (during
standard work hours vs. after work hours or in the office vs. at home).
Some educator contracts state that creative works by an educator are
owned by the educator, while others state that they are owned by the
school or district. So, if you would like to know who holds the
copyright of works you create as part of your job, you should check
your teaching contract or contact your employer.

Usage
Copyright generally means that others cannot use copyrighted
material without the permission of the author and that permissions
are restrictive. For instance, downloading a bootleg version of a movie
is a violation of copyright, because you did not purchase the copy
from the copyright holder. Further, even if you do purchase the movie
from the copyright holder, you can only use the movie in the ways that
the copyright holder allows (e.g., for private home use, not for public
use). Thus, by purchasing a copy of a work, you do not "own" that
work in the sense that you are not free to do whatever you like with it.
You must still abide by any copyright restrictions placed on the work,
which might determine how and where you use the work, your ability
to make copies of the work, and your ability to modify the work.

Linking
You can generally provide a web link to copyrighted material from
your own materials without permission from the copyright holder.
This is different from copying/pasting the copyright material into your
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own work, because it allows the copyright holder to maintain control
of their content and to generate revenue through web traffic. The
primary exception to this rule would be if you provided a link to
materials that should not be publicly accessible and, therefore,
allowed your users to bypass restrictions placed on the content by the
copyright holder.

Losing Copyright
Copyright comes with a time limit. The purpose of this is that the U.S.
government recognizes that copyright can only benefit the copyright
holder for so long and that at some point copyright should expire.
Currently, the U.S. copyright law states that copyright ends 70 years
after the death of the author. Upon expiration, copyrighted materials
move into the public domain. Copyrighted materials may also lose
their copyright status under other conditions. For instance, a
copyright holder may relinquish the copyright status on their work,
thereby allowing it to pass into the public domain.

Copyright and Technology
Advancing technologies, ranging from the player piano to the internet,
have always had unintended consequences for copyright law, and
copyright law has always been slow to keep up with advancing
technologies. Copyright law has changed over time, but as new
technologies empower us to share and use copyrighted materials in
new ways and at greater scale, copyright law gradually changes in
response.

Common Questions
Can I legally show my students videos from my Netflix account
or other subscription streaming services?
No. Your license agreement does not allow you to do this.
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When is a work copyrighted?
As soon as it is created or published.
Does a work need to be published to be copyrighted?
No, though it must be in some physical form (e.g., manuscript,
recording).
Does an author need to register their work in order for it to be
copyrighted?
No. Authors may register their work with the US copyright
office to protect against infringement, but even unregistered
works are copyrighted.
If something is labeled with a copyright symbol (i.e., ©), does
that mean it is copyrighted?
Maybe. The symbol serves as a reminder, but the copyright
might have expired.
If something is not labeled with a copyright symbol (i.e., ©),
then is it copyrighted?
Maybe. Maybe not. The label has nothing to do with whether or
not a work is copyrighted. The copyright label only serves to
remind and to inform. If you see no label, you should assume
that the work is copyrighted and look into the matter further.
Can I link to copyrighted materials?
In most cases, yes. Just be sure that you are linking to the
resource as it is provided by the publisher (not uploaded to
someone's personal server, etc.) and that your link does not
bypass a copyright holder's login system.
Can I embed copyrighted materials into my presentation or
website (e.g., YouTube videos)?
That depends on the terms of the license that the copyright
holder has released the content under. Generally, if a site like
YouTube gives you an embed script, then you are able to use it
(provided that you do not change the script, remove attribution,
etc.).
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What do you think?
In the last classroom that you taught or observed in, was a DVD
player available for showing movies to the entire class?
a. Yes
b. No

Additional Resources
Some additional resources that may be useful for exploring these
issues include the following:
Copyright Crash Course
Wikipedia: Copyright

Fair Use
Fair use is an exception or limitation to copyright law that allows you
to use some copyrighted materials in particular circumstances without
the copyright holder's permission. Specifically, if used for nonprofit
educational purposes, some copyrighted materials may be used for
teaching, but your use (a) should directly relate to your educational
goals, (b) should only utilize a relatively small portion of the work, and
(c) should not negatively impact the copyright holder's ability to profit
from the work. Fair use means that copyright-restricted works can be
used for educational purposes without permission under certain
conditions. The four guiding principles that determine if use is fair
are:
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"Fair Use" Guiding Principles
Nature of Use
Type of Work
Amount Used
Commercial Impact
The first principle covers what you are doing with the content and
whether your use aligns with the author's intended use. Fair use only
applies to uses of works that are transformative in nature. This means
that your intended use must be different from the author's intended
use. Consider a novel. You can quote lines from a novel in a paper you
write without permission from the novel's author, because you are
writing the paper to analyze literary elements of the novel, not to tell
a story. If, however, you took those same lines and placed them in
your own novel, then that would not be an example of fair use,
because your intended use would be the same as the original author's
intended use. In education, this means that using someone else's
educational content (e.g., an image from their textbook) would not
generally be fair use, because your intent is the same as theirs (i.e.,
educational and, therefore, non-transformative).
The second principle gives greater flexibility in using informational or
factual works than to artistic or creative works. Thus, copying a few
pages from an encyclopedia is viewed as more conducive to fair use
than doing the same with a detective novel, because the information's
benefit to society is readily apparent.
The third principle ensures that you only use as much of the
copyrighted material as is necessary to achieve your goal. Thus,
quoting a line from a novel would be considered fair use, but copying
multiple chapters of the novel for this purpose would not. This is both
a quantitative and qualitative consideration, in that you should not use
more than is needed but fair use also should avoid using the "heart" of
a work.
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And the fourth principle considers whether copyrighted material
negatively impacts the author's ability to profit from it. If you copy an
article to share with your class, this would prevent the copyright
holder from selling access to the article, which would be a violation.
However, if you were to copy only a paragraph of an article for this
purpose, it is less feasible that the copyright holder would potentially
lose money on this use. So, this use would be more defensible as fair
use.

Examples
If it weren't for fair use, you wouldn't even be able to write a paper
that quoted a famous author without permission, which would be a
serious matter for scholarly progress. Consider this quote from The
Fellowship of the Ring:
All that is gold does not glitter, not all those who wander
are lost; the old that is strong does not wither, deep
roots are not reached by the frost. - J. R. R. Tolkien
Without fair use, the inclusion of this quote in a paper on literary
analysis or on this website would be a copyright violation, because I
did not seek the author's prior consent to make a copy of this text
from his book or to distribute it online. However, my use in this case
is a transformative use and is only large enough to make the
educational point, so it is allowable. Would being able to read this
quote on this website prevent someone from reading his book
(thereby depriving the copyright owner of profits)? Certainly not. On
the contrary, however, if I were to provide several chapters of
Tolkien's book online without prior permission from the copyright
holder, then this would certainly be a copyright violation that could be
acted upon.
Similarly, copying another teacher's lesson plan, changing a few
words, and posting it online would be a blatant copyright violation.
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Fair use becomes problematic in education if you are trying to use
educational works in your own creations (e.g., materials created
specifically for education, such as lesson plans or textbook chapters)
and/or you are using too much (such that it might prevent the owner
of the copyright from profiting from the work).

Guidelines
To determine if a desired use of copyright-restricted material would
fall under fair use, ask yourself four questions:
1. Use: Is the use transformative? (Yes = Fair Use)
2. Type: Is the work informational/factual in nature? (Yes = Fair
Use)
3. Amount: Is the use minimal? (Yes = Fair Use)
4. Impact: Does the use negatively impact the copyright holder's
ability to profit from the work? (No = Fair Use)
Fair use is a judgement call, but the call is made based on the
answers to these four questions. Thus, if your answer to all four
questions aligns with fair use, then your use would likely be judged as
fair. If the answer to one question does not align with fair use, then
your use might still be fair, but it increases the potential for it to be
judged otherwise. And so forth. In many court cases, uses that met
three criteria have been deemed as fair, and in others, uses that only
met one or two criteria have been deemed as fair, but there is never
any guarantee. In short, only a judge can determine if use is fair, but a
judge would use these four guidelines in making the determination.

Institutional Rules
To help safeguard their institutions and employees, many schools will
adopt rules for interpreting fair use. For instance, some institutions
will allow copyrighted materials to be used up to a certain percent of
the work (e.g., a section of a book can be copied as long as it
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constitutes 10% or less of the entire book). These rules are not perfect
reflections of the law but are rather interpretations intended to
protect.
Here's a comparison. Let's pretend that 55 mph is the speed limit
throughout the U.S. but that the government allows for people to
exceed this speed limit "a reasonable amount" in particular cases of
emergency. If such a law existed, it would be up to judges to
determine if any case of traveling faster than 55 mph constituted a
legitimate emergency case and if the actual speed was reasonable.
Like copyright, this law sounds fairly fuzzy. Let's also say that you are
a bus driver and your school has a rule that this law means that you
should only exceed the speed limit if a child is hurt and in these cases
you should never go faster than 65 mph. Though this is not actually
what the law says, it is your school's interpretation of the law and is
intended to keep you and the school safe.
Thus, when considering institutional rules, you should recognize that
they are intended to prevent you from breaking a rather fuzzy law but
that they also may not entirely reflect what the law actually states. In
any case, you are safest abiding by your institutional rules for fair use,
because this helps to ensure that your institution will be on your side
if there is any question about your copyright-restricted material use.

Parody
Parody is one example of fair use in which copyrighted materials may
be used to critique the author. Thus, using an image of someone to
critique that person would probably be fair use (as in the case of
Galvin v. Illinois Republican Party [https://edtechbooks.org/-PHQ]).
However, using one person's copyrighted works to critique a different
person or an unrelated social issue (as in the case of many memes)
would likely not be parody, since the copyrighted work is being used
to make fun of something other than the author or the work itself.
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Positive Examples
These are examples that would probably qualify as fair use (i.e. they
probably do not violate copyright):
Quoting a few sentences from a book in a paper on literary
criticism;
Adding text to a movie screenshot to critique/parody the movie;
Including a paragraph of text from a book in a quiz as
background for asking questions;
Showing a short clip from a popular movie to analyze how it
was made.

Negative Examples
These are examples that would probably NOT qualify as fair use (i.e.,
they probably violate copyright):
Copying pages from a workbook for students to complete;
Copying or remixing a lesson plan;
Creating a calendar of pictures that were photographed by
someone else;
Including a popular song as background music on a YouTube
video your students create;
Holding a public screening of a movie in the school auditorium
that you have purchased for personal use.

Navigating Fuzziness and Risk
Fair use can be very fuzzy, and it may be that educators violate fair
use regularly in their classrooms without worrying about legal
repercussions. Even if copyright is violated, the risks associated with
violation tend to vary by use. For instance, if you copy a lesson plan
for use in your classroom without first gaining permission, the odds
are that you will not run into any legal issues. However, if you try to
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sell this same lesson plan online or share it on your teacher blog, then
the legal risk increases. This does not mean that you should violate
copyright discretely, but merely that this decision would be based
upon a moral imperative rather than legal risk.

The Bottom Line
Fair use is complicated, only provides educators with limited
opportunities for use, and is typically more of a headache than it is
often worth when talking about any substantive use of copyrighted
materials.

Additional Resources
The U.S. Government has recently started archiving court cases
related to fair use, which may be instructive if you have specific
questions about what courts are classifying as fair use and not.
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What do you think?
If you followed all copyright restrictions, how do you think this
would impact your ability to effectively teach your students?
a.
b.
c.
d.

It would severely reduce my effectiveness
It would moderately reduce my effectiveness
It would somewhat reduce my effectiveness
It would not negatively impact my effectiveness

Public Domain
Copyright law varies from country to country, but in the US, public
domain is a technical term referring to works that are not subject to
copyright protection.

Categories
In general, there are three groups of works that are in the public
domain:
1. Old works for which the copyright has expired;
2. Exempt works that may not be copyrighted or that were
created under certain conditions;
3. Any works that have been released to the public domain by
their authors.

Old Works
Under the current US copyright law, any copyrighted work will
automatically pass into the public domain 70 years after the death of
the author. In general terms, this means that virtually all classics or
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materials older than 120 years or so are in the public domain. To
determine if a specific work is in the public domain, however, you
should find out when the author died and add 70 years in order to
determine the date at which copyright expires. This time frame has
gradually been lengthened in US history, so some works may still be
in the public domain that were created less than 70 years ago.

For instance, the John Wayne and Maureen O'Hara movie McLintock!
passed into the public domain in 1994.

Examples of public domain works
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Exempt Works
Copyright can only be applied to specific types of works (e.g., books,
movies, images) and cannot be applied to general knowledge. For this
reason, you do not need to cite anyone when you state a fact (e.g.,
"Jupiter is a planet"). Works may also be exempt from copyright if
they are created under certain conditions of employment. The most
common example of this is when US federal employees create works
as part of their jobs (e.g., active duty service men and women in the
armed forces). Works that these individuals create (e.g., photos taken)
may be placed in the public domain by virtue of their employment.

Released Works
Any author of a work may willingly choose to release that work into
the public domain by simply labelling the work (e.g., "this work is in
the public domain"). By doing so, the author gives anyone (e.g.,
individuals, corporations) the right to use their work for any purpose,
without limitation or attribution.

Use
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Since they are not subject to copyright protection, public domain
works may be used for anything and may even be included in
derivative works and may be sold. There are no restrictions on how
these works may be used, so citations are not generally needed.
However, if you are using public domain content in your own work, it
would be helpful for others to know what parts are public domain so
that they know how they might also reuse and remix your content.
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Public Domain Repositories
Project Gutenberg
Army Photos
Library of Congress
Internet Archive
U.S. Fish and Wildlife Digital Library
Digital Public Library of America

"Open" Resources

Watch on YouTube https://edtechbooks.org/-EC

The terms "open" and "free" colloquially have many meanings. "Free"
generally has two that may be best understood by referring to their
latin equivalents: gratis and libre. In the context of openly licensed
materials or open educational resources (OER), gratis means that
content and resources are provided at no cost. Libre means that you
are free to do what you want with these resources.
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As an example of this distinction, you may find a website with "free"
videos or another teacher may give you a set of old textbooks for
"free" (i.e. gratis), but you are not then able to do whatever you want
with those videos and textbooks (i.e. not libre). Similarly, Facebook is
a gratis service, because you do not pay a fee to use it, but it is not a
libre service, because you have only limited access to download,
delete, or control your data within Facebook. This is an important
distinction, because many gratis resources are not libre, and when we
talk about openness, we mean both gratis and libre.
That is, Gratis + Libre = Open.

The Five "R's" of Openness
Openness may mean different things to different people, but when we
refer to openness in terms of open licensing, we mean openness that
gives us freedom to do the five R's:
1.
2.
3.
4.
5.

Retain
Reuse
Redistribute
Revise
Remix
Hilton III, J., Wiley, D., Stein, J., & Johnson, A. (2010).
The four Rs of openness and ALMS analysis: frameworks
for open educational resources. Open Learning, 25(1),
37-44.

Open Licensing
Sometimes authors of creative works who want to share them openly
want to maintain some control over what others can do with their
work. Open licenses have arisen as a means for openly sharing
content while at the same time preserving desired rights to the
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author.
Open licenses find a nice balance between the restrictions of
copyright and the unfettered freedoms of public domain, making them
a good option for anyone desiring to share their work with others.
Authors of creative works have the right to release those works under
any license they choose (except in cases where they have signed over
that right to a publisher, employer, etc.). The table below provides
three examples of common open licenses.
Table 1
Common Open Licenses
Common Open Licenses
Name
Creative Commons
GNU General Public
License (GNU-GPL)

MIT License

Image

Links
• Creative Commons
• GNU License
• Wikipedia: GNU General
Public License
• MIT License Template
• Wikipedia: MIT License

Creative Commons

To help authors to release their works easily and in a manner that
safeguards the rights that they care about, a number of template
licenses have been created by Creative Commons. Many works found
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on the internet are licensed under one of these types of licenses, and
in general, you do not need permission to use them in your work as
long as you properly attribute (cite) them and abide by any additional
requirements set forth in the license.
There are four requirements that may be appended to a Creative
Commons license. These include the following:
BY or Attribution—This means that you need to cite the
author of the original work if you copy or remix it.
SA or Share-Alike—This means that if you remix the work you
should release it under a license similar to the one it was
initially released under.
ND or Non-Derivative—This means that you cannot make
your own derivative version (or remix) of the work but must use
it exactly as-is.
NC or Non-Commercial—This means that you cannot use the
work for primarily financial gain.
Depending upon which of these requirements are placed on the work,
Creative Commons licenses can come in a number of varieties. Two
are merely restatements of Public Domain, while the rest provide the
author of a work the ability to retain varying levels of control of how
the work may be used. The most common Creative Commons license
is the CC BY or Creative Commons Attribution license, which
basically means that others are free to reuse, redistribute, revise, and
remix the creation as long as they properly cite the author. More
information about each license is provided in the following table.
Table 2
Creative Commons License Brief Explanation Table
Creative Commons License Brief Explanation Table
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License Type

Image

Brief Explanation

Public Domain - By Age

These works are not subject to copyright or
their copyright has expired.

Public Domain - Released

These works are released to the public domain
by their authors before the copyright has
expired.

Creative Commons Attribution (CC BY)

Others may reuse, redistribute, revise, and
remix the creation as long as they cite you.

Creative Commons AttributionShareAlike (CC BY-SA)

Others may reuse, redistribute, revise, and
remix the creation as long as they cite you and
share their creation under an identical license.

Creative Commons AttributionNoDerivs (CC BY-ND)

Others may reuse and redistribute the creation
as long as they cite you. They may not create a
derivative work (e.g., remix or revise it).

Creative Commons AttributionNonCommercial (CC BY-NC)

Others may reuse, redistribute, revise, and
remix the creation as long as they cite you, but
they may not use your creation for commercial
purposes.

Creative Commons AttributionNonCommercial-ShareAlike (CC BYNC-SA)

Others may reuse, redistribute, revise, and
remix the creation as long as they cite you and
share their creation under an identical license.
They may not use your creation for commercial
purposes.

Creative Commons AttributionNonCommercial-NoDerivs (CC BY-NCND)

Others may reuse and redistribute the creation
as long as they cite you. They may not create a
derivative work or use it for commercial
purposes.

Finding Resources
In general, copyleft and creative commons licenses value open
practices in that they seek to allow for works to be reused,
redistributed, revised, and remixed, but licenses vary based upon
what is required of the user to do so legally. For instance, the
Creative Commons Attribution license (or CC-BY) requires the user of
the work to give appropriate credit, to provide links to the license,
and to not suggest that the original author endorses any new use of
the resource.
More details on specific Creative Commons licenses are provided in
the Attribution Quick Reference Guide. There are a number of
libraries, search engines, and search engine settings that allow you to
easily search for copyleft-licensed works. Some popular examples
include:
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Wikimedia Commons [http://commons.wikimedia.org/]
Creative Commons Search
Flickr Creative Commons
Vimeo Creative Commons
Creative Commons Music
If a work (e.g., picture, song, video, lesson plan, rubric) does not have
a statement of copyright status attached to it, you should generally
assume that it is copyrighted and should seek permission before using
it.

Open Content Providers
Open educational resources (OER) are made available from many
different sources. This list, though not exhaustive, includes some of
the more prominent providers. Explore these resources to find
material that will be useful for you in your classroom, taking note of
what licenses resources are released under. Watch this video to learn
how to use a search engine to find openly licensed content.
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Watch on YouTube https://edtechbooks.org/-Iu

Open Textbooks & Curricula
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Open Textbook Library
CK-12 [http://www.ck12.org]
Saylor [http://saylor.org]
Boundless [http://boundless.com]
Connexions / OpenStax Library [http://cnx.org]
Textbook Equity [http://textbookequity.org/]
BC Campus [http://open.bccampus.ca]
Wiki Books [http://en.wikibooks.org]
Odell Education [http://odelleducation.com/]
Cool4Ed [http://www.cool4ed.org/]
Merlot [https://edtechbooks.org/-GA]

Search Engines
1.
2.
3.
4.
5.

OER Commons [https://www.oercommons.org/]
Creative Commons Search
Google Advanced Search*
Google Advanced Image Search*
Yahoo Image Search**

* Be sure to set usage rights to "free to use share or modify". ** Be
sure to click the arrow in the top left and select "Labeled for Reuse" in
the bottom left.
Text Content Providers
1. Wikipedia - open encyclopedia
2. Simple English Wikipedia [http://simple.wikipedia.org] simplified encyclopedia
3. Project Gutenberg [http://www.gutenberg.org] - public domain
texts
4. Wiki Source [http://en.wikisource.org] - source materials
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5. Wiki Quote [http://en.wikiquote.org] - quotations
Media Content Providers
1. Wikimedia Commons [http://commons.wikimedia.org] - open
media
2. Digital Public Library of America [http://dp.la/] - public domain
works
3. LibriVox [http://librivox.org] - public domain audio books
4. Photo Pin [http://photopin.com] - open photos from Flickr
5. Internet Archive [https://archive.org] - public domain works
6. U.S. Army [http://www.army.mil/media/] - public domain images
7. Flickr - creative commons images
8. Vimeo - creative commons videos
9. Creative Commons Music - various creative commons music
sites
10. Jamendo [http://jamendo.com] - creative commons music
11. Animal Photos [http://animalphotos.info] - animal photos
12. Library of Congress [http://www.loc.gov/] - public domain works
13. Internet Archive [https://archive.org] - public domain works
14. U.S. Fish and Wildlife Digital Library
[http://digitalmedia.fws.gov/] - public domain works (mostly)
Open Courses
1. Lumen Learning
2. Wikiversity [http://en.wikiversity.org]
Tools
These tools are not technically open educational resources, but they
can be used to aide you in creating, remixing, and sharing open
educational resources.
1. Google Drive [http://drive.google.com] - write and create
collaboratively
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2. Rewordify [http://rewordify.com] - simplify difficult texts
3. Text Compactor [http://textcompactor.com] - summarize texts
4. Simplish [http://www.simplish.org] - simplify and summarize
texts
5. Open Text Summarizer - summarizes nonfiction texts

Attribution
When utilizing someone else's work in your own, you should be sure to
attribute the work. In education, we generally use formatting
guidelines from the American Psychological Association (APA), and
you should cite works according to these guidelines if required for a
research paper or publication. However, in most situations, a simpler
citation that includes the work's title, author, license, and url will be
appropriate. All work licensed under an open license will generally
require you to properly attribute (cite) the resource in order to use it
in your own work. Failure to properly cite one of these works if it
is used in your own work is a violation of copyright. At minimum,
you should attribute such works with the following information:

Attribution Items
Title
What is the title of the work (e.g., name of article, picture, or
song)?
Author
Who created the work?
Source
Where did you find the work (e.g., url)?
License
What license is the work shared under (e.g., CC BY)?

As possible, you should also cite these works in such a way that it is
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clear to which portions of content the attribution refers and so that
the attribution is prominent. For instance, if you include a Creative
Commons image in a book you are writing, the attribution should be
included as a caption under the image. When such attribution is not
possible, including attributions in a works cited page is acceptable if it
is clear to which content each reference belongs (e.g., providing page
numbers).

Common Questions
If there is no author mentioned, how do I cite the resource?
Use the author of the website. If the website does not have a
mentioned author, use the name of the website (e.g., "CK-12").
What if there is no copyleft license or notice of public domain
mentioned?
Remember, just because no copyright symbol is present does
not mean that the work is open (e.g., not every page of a Harry
Potter book has a copyright symbol on it, but it is still
copyrighted). Since everything is automatically copyrighted,
you should generally assume that all work is copyrighted and
should not treat it as an open resource without further
investigation.
May I use a copyrighted work if I properly cite the author?
This depends on what you are using it for (see the discussion of
fair use), but generally, you must have written permission to
use it in any significant way.
If something is marked as released under Creative Commons, but
there is no specific license identified, which should I use?
You should probably either use the most restrictive license (CC
BY-NC-ND) or the most common license (CC BY). Use your best
judgment.
Can I modify or revise an openly licensed work?
This depends on the license. In most cases, yes, but you may
need to release your new work under the same license. The
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primary times when you cannot do this would be when the
license prohibits derivative works (e.g., any CC BY-ND and CC
BY-NC-ND).
Can I use Royalty Free work?
This is tricky. Royalty Free does not generally mean free as in
libre (i.e. free to use for whatever). Rather, it typically means
that you can use a work in a very specific way (e.g., print an
image up to ten times) that will vary based upon the provider.
So, royalty free is essentially just another way of saying
copyrighted, but the material might be able to be used in some
very limited manner without paying a fee.
If something is copyrighted, does that mean I cannot ever use it?
You can use it if you have the copyright holder's permission.
You can always contact the owner and ask her/him if you can
use it. Open resources are handy, simply because they make it
easier for you to use materials without asking permission every
time you want to use something.

Sharing Your Work
As the author of a creative work, you can release your it under an
open license or into the public domain. All you need to do is place the
Creative Commons license on your work or state that the work is in
the public domain, and this allows others to know how they can use it.
For example, by simply placing "CC BY 3.0" below a picture, you give
anyone the right to use it for any purpose as long as they attribute you
as the author.

Public Domain or an Open License?
As the author of a creative work, you should consider the benefits of
different ways of sharing your content. In short, if you don't care how
it's used but just want others to be free to use it, release it into the
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public domain. If you want to receive credit (be cited) when others
use it, use CC BY 3.0. For a more detailed walkthrough of how you
should release your content, follow the steps provided in the table
below.
Table 3
Workflow for Choosing a License
Step

Question

Yes

No

1

Do you want to allow anyone
anywhere to use the work
however they want without
giving you credit?

Public Domain Go to
Step 2

2

Do you want to make sure that
anyone who uses your work also
shares their work in the same
way?

Go to Step 3

Go to Step
4

3

Do you want to prevent others
from profiting from your work?

CC BY-NC-SA

CC BY-SA

4

Do you want to prevent people
from changing your work?

Go to Step 5

CC BY

5

Do you want to prevent others
from profiting from your work?

CC BY-NC-ND CC BYND

More details about the Creative Commons licenses may be found on
the Creative Commons website.

Example Statements
Releasing your work under an open license is easy. Just place a
statement somewhere on your work that states what license you are
releasing it under. The Creative Commons site provides a wizard to
create a statement and image for you, or here are a few more
examples:
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This work is released under a CC BY 3.0 open license by [Your
Name Here].
This work is released into the public domain.

Conclusion
This chapter has provided an overview of copyright, public domain,
fair use, and open licenses. With this knowledge, teachers should feel
sufficiently knowledgeable to use copyright-restricted resources in a
legal manner. They should also be able to find and use public domain
and openly licensed resources, to properly cite them, and to release
their own creations openly.
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Color Theory in Experience
Design

1. Introduction
Outside the visual arts, color is rarely discussed by professionals in
systematic ways; among UX and LX designers, color is generally
approached in a strange give-and-take between technical prescription
and intuitive preference. For instance, the color system outlined in
Google’s (n.d.) material design visual language provides precise
guidance on how to generate a color palette from your primary color,
what to use secondary colors for, and what colors are typical for
specific elements (such as error screens), but it does not provide
designers any guidance on what primary color to pick in the first
place, when to use different types of color palettes (e.g., analogous,
complementary, triadic), and why. This is likely because, when
designing for a corporate client, designers are generally constrained
by the preexisting branding requirements of the client (e.g., “our
brand is periwinkle”) and must work from a particular color starting
point when making designs.
But designers must also often counterbalance their own and their
clients’ everyday assumptions and receive wisdom about color in
order to create the best designs for end users and learners. For
instance, early in my professional experience creating websites for
clients, I delivered a mock-up that I thought looked good and met the
client’s requests perfectly. Frustrated with what he saw, the client
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furrowed his brow and slowly replied, “Yes, but I need something that
pops.” This, in turn, frustrated me, because the only explanation he
then provided would result in what I thought would be a terriblelooking design. “What does ‘pop’ really mean?” I thought. And “How
can I fix the design to be something that the client likes and
something that I’m proud of?” And, perhaps most of all, “How can my
client and I communicate about color in more meaningful ways?”
Beyond this need for designers to meaningfully communicate with
clients, color also plays an important affective and cognitive role in
learners’ experiences. Various studies have shown that color-use
influences learner attitudes, comprehension, and retention (Gaines &
Curry, 2011). Some of these influences are broadly universalizable,
others are contextual to the learner’s age, gender, or culture, and
others are contextual to the subject matter or learning objectives
being targeted. Furthermore, there might be multiple right or useful
ways to use color in a particular design project, and inappropriate or
ineffective color-use in one project might constitute optimal use in
another.
For these reasons, clear and reliable guidance on the what, how,
when, and why of color-use in UX design is difficult to come by, and
the problem of effective color-use is a prime example of why UX
design cannot be approached purely as a science nor as an art but as
a craft that synergistically merges the two. Toward this end, I will
begin in this chapter by briefly providing some rudimentary
groundwork on the underlying physics of color and its technical
representation in digital formats. This will give us a common
vocabulary for referencing specific aspects of color (e.g., hue vs. tone)
as well as some technical knowledge necessary for actually using
color in UX design scenarios. After this, I will briefly explore the
science of color-use in UX by summarizing some of the emotional,
cognitive, and physiological effects that color-use has on learners.
With this backdrop, I will then address some of the applied aspects of
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color-use that will influence the craft of UX and ongoing research in
this area. Specifically, I will explore four guiding considerations of
color-use that should be addressed in UX — contrast, attention,
meaning, and harmony—and then provide guidance on how to use
color schemes to improve harmony by highlighting five dominant
types of color schemes. I will then conclude by providing specific craft
guidance on using color for UX projects and comment on how this
should connect to ongoing UX research.

2. Physics of Color and Technical Use
We must begin this chapter by reviewing some of the physics of light
and color. Color is a visual sensation created in the mind of the viewer
from differing wavelengths of visible light, ranging from lowfrequency reds to high-frequency violets. Some color sensations can
be produced by a narrow band of wavelengths, but others are
produced as multiple color wavelengths are mixed. For instance,
when all color wavelengths are mixed together, they make white light,
which is why a dispersive prism can be used to split white light into a
rainbow of spectral colors. By putting the primary colors of light
together, then, white can be created additively, as in Figure 1, and
various other colors not even present in the rainbow can be created
by mixing light wavelengths together, such as red and blue making
magenta.
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Figure 1
Additive and Subtractive Color Mixing Models

For this reason, computer screens and other displays have historically
used differing intensities of only three primary colors of light: red,
green, and blue (RGB). On screens, RGB dots are used in combination
to create colors ranging from white, when they are at full intensity, to
black, when they produce no light, and the millions of color
combinations in between that are commonly used in movies, games,
simulations, images, and websites.
However, visual media that rely upon physical materials to reflect
(rather than generate) light, such as ink and paint, operate from a
different model of color mixing. Though mixing a green ray of light
and a red ray of light would produce yellow light, combining green
paint and red paint would produce a dark brown. Such materials rely
upon a subtractive color model (cf. Figure 1), wherein black is the
sum of all colors and white is the absence of all colors.
Recognizing these two approaches to color mixing is important to
understand common notations present in design and authoring
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software. For instance, when creating a website, video game, mobile
app, or illustration, RGB notations are used, such as rgb(255,255,0)
for yellow, wherein each number represents a range of 0 (lowest) to
255 (highest) intensity for the primary colors. Hexadecimal notations
are also commonly used as a shorthand version of RGB, such as
#ffff00, wherein the number ranges are converted to a base-16
number system, ranging from 0 to ff, without losing any information.
When creating print media, on the other hand, CMYK notation is
commonly used, such as cmyk(0,0,100,0) for yellow, wherein each of
the primary colors is represented as a percentage of intensity
(0-100%) and black is provided as a fourth color mixin, because true
black is difficult to make through mixing (in real-world applications,
mixing would only generate dark browns and grays). Table 1 provides
some notation examples of common colors.
Table 1
Notation Examples of Common Colors
Name

Additive

Subtractive

RGB

Hexadecimal

CMYK

White

rgb(255,255,255)

#ffffff

cmyk(0,0,0,0)

Black

rgb(0,0,0)

#000000

cmyk(0,0,0,100)

Red

rgb(255,0,0)

#ff0000

cmyk(0,100,100,0)

Green

rgb(0,255,0)

#00ff00

cmyk(100,0,100,0)

Blue

rgb(0,0,255)

#0000ff

cmyk(100,100,0,0)

Yellow

rgb(255,255,0)

#ffff00

cmyk(0,0,100,0)

Cyan

rgb(0,255,255)

#00ffff

cmyk(100,0,0,0)

Magenta

rgb(255,0,255)

#ff00ff

cmyk(0,100,0,0)

Gray

rgb(127,127,127)

#808080

cmyk(0,0,0,60)

Using any of these notations can generate millions of possible colors,
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including basic hues of the color wheel, low-saturation tints of hues
(by lightening toward white), and low-brightness shades of hues (by
darkening toward black), along with various mixtures of tinting and
shading (cf. Figure 2). These terms will be important moving forward
for understanding research on color effects for the affective domain.
Thus, hue represents the color’s position around the color wheel,
saturation represents the amount of white mixed with the hue, and
brightness represents the amount of black mixed with the hue.

Figure 2
Hue, Saturation, and Brightness on a Color Wheel
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3. Emotion and Learning
When people see the colors represented by the color wheel, they have
various emotional and physiological reactions to them that influence
their general experiences and also their learning. Alongside the
famous cognitive domain taxonomy, Krathwohl, Bloom, and Masia
(1964) also proposed a taxonomy for what they called the affective
domain of learning, or the aspects of learning related to “a feeling of
tone, an emotion, or a degree of acceptance or rejection” as expressed
through goals oriented toward “interests, attitudes, appreciations,
values, and emotional sets or biases” (p. 7). Recent years have seen
renewed interest in the affective domain as educators and designers
have struggled anew with how to support learner self-regulation,
motivation, and persistence. Though the connection between color
and learning may not be obvious at first, by influencing learner
emotion, attitude, and interest, color can influence learner behaviors
and attitudes, which in turn will influence their learning.
For instance, one study found that exposure to red prior to taking an
IQ test subconsciously impaired performance, presumably by
triggering feelings of danger, failure, or avoidance (Elliot et al., 2007).
Though such emotional states might have limited direct effects on
learning outcomes, they may play an important role in improving
intrinsic motivation and the desire to keep working (Heidig et al.,
2015); by employing positive emotion cueing, designers can help
increase mental effort in the learner, reduce perceived difficulty of the
material (Park et al., 2014; Um et al., 2012), and improve learner
comprehension (Plass et al., 2014).
Psychological research on the emotional effects of color extends at
least back to the 1950s. In their early work, Guilford and Smith (1959)
found that, among the spectral colors, people preferred blue and
green the most and orange and yellow the least. Subsequent research
found that preference for blue, green, and white generally persisted
across countries and cultures (Adams & Osgood, 1973). Additionally,
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some emotional reactions are universal, such as anger, fear, and
jealousy being connected to red and black, while other colors, like
purple, are more culturally mediated (Hupka et al., 1997) or are
influenced by gender (Osgood, 1971). For example, women take
slightly more pleasure in bright colors and find highly-saturated colors
slightly more psychologically arousing (Valdez & Mehrabian, 1994).
Furthermore, even within a single culture, emotional reactions may
change somewhat with age, such as childhood feelings of surprise and
fear toward green maturing into adult feelings of happiness (e.g.,
Terwogt & Hoeksma, 1995).
Physiologically, studies have shown that human reactions to color
vary by hue, with long-wavelength colors (e.g., reds and yellows)
being more arousing (e.g., increased heart rate and respiration) than
short-wavelength colors (e.g., blues and greens; Jacobs & Hustmyer,
1974; Wilson, 1966). Additionally, many studies have found that
primary hues are preferred to secondary or tertiary hues (Kaya &
Epps, 2004) and that all of these are preferred to grays. Some of these
reactions can be explained by differences in intensity of photoreceptor
stimulation in the eye (e.g., the eye is more sensitive to red), while
others likely stem from common environmental experiences, such as
associating white with cleanliness and blacks and grays with dirtiness
(Valdez & Mehrabian, 1994).
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Figure 3
Four Interface Examples That Cue Differing Behaviors, Trust Levels, Attitudes, etc.

For a simple example of how this relates to UX and LX design,
consider the password prompt interfaces in Figure 3. If you were
presented with each of these interfaces, how might your emotional
and behavioral reaction to the prompt differ based upon its color?
Seeing a red prompt might make you stop and consider “Is this really
a secure site?” On the other hand, an orange prompt might get your
attention but be somewhat confusing or concerning, a gray prompt
might feel bland but also seem secure or professional, and a blue
prompt might make you feel comfortable about entering your
information when perhaps you should not be comfortable.
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Figure 4
Four Display Options for a Mobile App About Pet Care With Variations on Color and Content

Similarly, suppose you are designing a learning app for young
children on how to responsibly care for pets. In Figure 4, four options
are provided. Two use an aggressive image of an adult dog (1, 2),
while the other two use an image of a soft puppy (3, 4). Two also use a
blood red background (1, 3), while the other two use a neutral grey (2,
4). What might be student affective reactions to each of these and
how might it impact their ability to achieve learning objectives related
to being a responsible pet owner? Option (1) feels very aggressive
both because of the content and the color, while option (3) feels like
there is a mismatch between what is shown and how it is presented,
thereby evoking conflicting emotions. The neutral grey background
for (2) and (4), however, allows the content to convey the emotion.
And so, if our objective is for children to have a positive attitude
toward pet care, then option (4) would likely be the best.
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Figure 5
Brightness and Saturation Levels of the Primary Blue Hue With Four Examples

Hue is not the only aspect of color that influences emotion; a color’s
saturation (how little white is mixed in with it) and a color’s
brightness (how little black is mixed in with it) also has an effect. In
research studying color effects on the Pleasure-Arousal-Dominance
emotion model (Mehrabian & Russell, 1974), brightness was found to
positively impact pleasure and negatively impact arousal and
dominance, while saturation positively impacts all three (Valdez &
Mehrabian, 1994). So, if using a blue hue, as in Figure 5, you might
choose from a variety of brightness and saturation levels, including (a)
light blue (high brightness, low saturation), (b) azure (high brightness,
high saturation), (c) blueish gray (low brightness, low saturation), or
(d) indigo (low brightness, high saturation). Though each of these is a
variant of blue, they all elicit different emotional responses in the
viewer. For instance, (a) would be fairly pleasurable but not arousing
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or dominant, eliciting a feeling of tranquility; (b) would be the most
pleasurable and somewhat arousing but not dominant, eliciting a
feeling of amazement or awe; (c) would be the least pleasurable and
fairly neutral for arousal and dominance, eliciting a feeling of
boredom; and (d) would be the most arousing and dominant but
neutral-positive for pleasure, eliciting more of a feeling of boldness or
antagonism (Valdez & Mehrabian, 1994). In fact, brightness and
saturation account for two-thirds to three-fourths of the detected
variance in users’ feelings toward color (Valdez & Mehrabian, 1994).
This means that shifting from soft pink to blood red in a design would
likely impact users’ feelings more than shifting from soft pink to soft
green or blue.

Figure 6
Four Variations of the Same Design That Elicit Different Affective Responses

In addition, the context of color-use is important, as in the case of
otherwise pleasant colors being used in inappropriate or unnatural
ways (Valdez & Mehrabian, 1994). Consider the four variations of the
same website design in Figure 6. Which of the four color variations is
your favorite? For most people, (1) would likely be the preferred
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variation, because not only are the colors pleasant but the color-use
more appropriately aligns with prior positive experience. In the other
examples, the skin color of the hand looks a bit green, which may
subconsciously suggest experiences of bodily disease or death to the
user; similarly, the stems of the tulips in (4) are red rather than the
expected green, which signals to the user that the experience is
artificial or unnatural. In such ways, whether intentionally or
unintentionally, our designs evoke affective responses; just as (1)
might evoke memories of beautiful blue spring days with new life, the
others might conversely evoke experiences of sadness, frustration,
confusion, or discomfort, all of which will influence a user’s
motivation and persistence with using the product.

4. Guiding Considerations
All of this research into the science of color-use is valuable, but how
each of us then translates these findings into the actual, embedded
craft of UX and LX design is a different matter. For this reason, a few
considerations may be useful for guiding any color-use in UX and LX
projects, including attending to contrast, attention, meaning, and
harmony.

4.1. Contrast
First, ensuring high contrast is important in all designs for aesthetics
but is especially important in those that use text. It is also a legal
requirement for many UX projects to meet minimum accessibility
expectations in many countries, such as those stipulated in the W3C’s
Web Content Accessibility Guidelines (WCAG) 2.0. Contrast problems
are widespread in learning products. In fact, a recent study on K-12
school website accessibility across the U.S. found that contrast errors
were the most common type of error among all sites (Kimmons &
Smith, 2019). Contrast errors arise because, though two similarlysaturated colors, such as crimson and blue, may look quite different to
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most viewers, when superimposed (as in Figure 7) they can become
difficult to decipher from one another. As a simple check of this,
colored designs can be converted to grayscale to allow you to quickly
see how similar the colors are to one another, or an automated
contrast checker like the one provided by WebAIM can be helpful. To
solve contrast problems, white and extremely light tints should be
used to contrast highly-saturated colors, and black and dark grays
should be used to contrast light tints.

Figure 7
Low-Contrast and High-Contrast Examples of Analogous Color-use With Grayscale Conversions

4.2. Attention
Second, colors can be used to quickly and efficiently draw the
attention of the eye to visual elements that matter. For instance, one
eye-tracking study found that adding random colors to word labels on
a grayscale figure moderately improved learner retention and transfer
performance by improving the efficiency by which learners could
differentiate textual elements (Ozcelik et al., 2009). On an app or VR
interface, this might mean using a vibrant color only to effectively
draw the learner’s attention to a few important elements, such as
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commonly-used buttons or interactive elements necessary for
progression. Similar principles are often applied to print media, with
color only being applied to text in the case of headings, key terms, or
blockquote elements. Any variation in color will generally draw the
eye of the learner to the variation, and this means that UX designers
should use this principle to intentionally draw user attention to
elements that matter and avoid unnecessary color variation in
elements that are less important. It also means that color cues can
effectively be used as guideposts for directing the learner through
progressive elements and to influence user pathways in desired ways.

4.3. Meaning
Third, because color conveys emotional (and sometimes even
conceptual) meaning to learners, colors should be used in a manner
that synergistically emphasizes the intended meaning conveyed by the
overall project and individual content elements. As with the pet care
mobile app example in Figure 4, improperly using color can subvert
intended meaning or set a tone that is either unhelpful, dissonant, or
repulsive for learners. As mentioned early, actual meaning and
affective influences of color can be complicated, contextual, and
individual, but some influences are fairly universal, such as grays
denoting lack of importance; warm colors evoking passion, dissent, or
engagement; cool colors evoking comfort, closeness, or agreement;
and so forth.

4.4. Harmony
And fourth, to use colors well in any design effort, the designer must
not only understand the emotions elicited by each color itself but also
understand how to use colors together in harmonious ways that meet
the intended purposes of the project. For instance, it is common
knowledge that warm (low-wavelength) colors draw more attention
than cool (high-wavelength) colors and that highly saturated colors
draw more attention than washed-out tints, but the mark of a skilled
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designer is knowing both (a) which colors to use and (b) how to use
varieties of colors together in harmonious and intentional ways.

Figure 8
Two Websites Using the Same Colors but in Different Ways

Even when two products use the exact same colors (as in Figure 8),
how the colors are used in relation to one another will influence the
learner’s affective experience. So, though both 8.1 and 8.2 use the
same colors, 8.1 might feel cool, inviting, and professional, while 8.2
might feel comical, distracting, and amateurish.
As a rule of thumb, many designers propose following what is called
the 60-30-10 rule, which is commonly used in many other visual fields
such as interior design. According to this rule, you should choose a
primary color to dominate 60% of the field of view, followed by a
secondary color for 30%, and an accent or tertiary color for no more
than 10%. For most UX products, this would mean choosing a
subdued color as the primary color (such as the soft blue in Figure 6.1
or the white in 8.1), a vibrant color as the accent color (such as the
pink in Figure 6.1 or the “Google” primary colors in 8.1), and some
variation in between as the secondary color (such as the brown in
Figure 6.1 or the grays in 8.1).
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5. Color Schemes
To promote color harmony, and to implement the other guiding
considerations mentioned above, most designers will begin color-use
in a project by developing what is called a color scheme. In most
cases, color schemes include between two and six colors that will be
drawn upon in intentional ways. Common color scheme types include:
(a) monochromatic, (b) analogous, (c) complementary, (d) complex,
and (e) achromatic. Each type has its own strengths and weaknesses
as well as design considerations to attend to, which I will now explain.
For each type, an example image will also be provided, which has the
five scheme colors depicted on the right of the image and the color
wheel placements of each scheme depicted on the bottom-right.

5.1. Monochromatic
Monochromatic schemes (from mono meaning one and chroma
meaning color) utilize a single, dominant color and provide color
variation only by using desaturated versions (or tints) of the dominant
color. Since they rely on a single color, monochromatic schemes are
easy to use in complicated designs to provide a sense of cohesion and
uniformity. Because the overall scheme is simple (i.e., one color), this
also allows you to include richer secondary elements, such as images
in a Facebook news feed or a variety of images on a Pinterest board.
The trade-off, however, is that monochromatic designs can be boring
or overbearing if highly-saturated versions of the dominant color are
overused. To prevent this, use plenty of white and very lightlysaturated tints of the dominant color to offset the more highlysaturated attention areas. In the provided example (Figure 9), the
navigation bars are a highly-saturated blue, so the content on the rest
of the design needs to use plenty of white and very light blues for
balancing.
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Figure 9
Monochromatic Schemes Use a Single Dominant Color of Different Saturations

5.2. Analogous
Analogous schemes rely upon two or more nearby colors on the color
wheel, generally spanning no more than one-third of the color wheel
(e.g., red and blue, green and orange, cyan and violet). Since the
colors are not distinct enough from one another to allow them to be
placed side-by-side, plenty of white space should be used to separate
instances of the two colors. Analogous schemes are more visually
interesting than monochromatic schemes, because they provide more
color variation, but they are also more difficult to use, because the
two dominant colors must be well-separated, and any other visual
elements should fit the scheme. In the provided example (Figure 10),
the crimson logo and carousel are clearly separated from the blue
events block, and the image in the carousel has a dominant blue color
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(via the woman’s sweater) that roughly matches the other blues in the
design. If the woman’s sweater was orange or green, however, the
design would struggle to be harmonious; because the design is
already using so much color complexity, any more complexity
introduced by the secondary elements would be distracting. Because
their colors are so close to each other on the color wheel, analogous
color schemes in particular may introduce contrast problems.

Figure 10
Analogous Schemes Use Two Dominant Colors Less Than One-Third of the Distance on the Color Wheel From One
Another

5.3. Complementary
The color wheel is conceived as circular rather than linear, because
colors on opposite sides when (additively) mixed will make white.
These are called complementary colors (cf. Figure 11).
Complementary schemes, then, use two dominant colors that are on
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opposite sides of the color wheel, such as blue and gold, orange and
cyan, or pink and green.

Figure 11
Complementary Colors Reside Opposite One Another on the Color Wheel

Complementary schemes are also visually interesting, but the
dominant colors are distinct enough from one another that they can
be used in closer proximity than can analogous colors. In the provided
example (Figure 12), the orange logo and thin horizontal bars are
placed nicely beside or on top of the dark blues of the menu.
However, though the two colors complement each other, one should
be treated as the visually dominant color, and the other should be
treated as the accent (in this case, the orange is the accent).
Typically, the cooler color is used as the visually dominant color, and
the warmer color is used as the accent. This allows for the design to
show interesting variation while also using the accent color to draw
the viewer’s attention to specific parts of the design, such as the logo,
buttons, or content separators.
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Figure 12
Complementary Schemes Use Two Dominant Colors on Opposite Sides of the Color Wheel From One Another

5.4. Complex
As the name suggests, complex schemes are the most complicated,
because they use three or more dominant colors equally situated
around the color wheel (e.g., blue, orange, red, and green). Because
they use so much color variation, the visual space that the color takes
up in the design should be very small and offset with plenty of white
space. In the provided example (Figure 13), the website uses a large
logo with four very different colors but offsets this by using little to no
color in the rest of the design. Because of their variation, complex
schemes can be very bright and interesting but can quickly become
overpowering if the visual footprint of any of the colors becomes too
pronounced (as in Figure 8.2).
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Figure 13
Complex Schemes Use Three or More Colors Equally Situated Around the Color Wheel From One Another

5.5. Achromatic
Achromatic color schemes (meaning no color) use only variations on
black, white, and gray. Of all the schemes, this scheme is the easiest
to use but can also be the least interesting, because it provides the
least color variation. Sometimes, however, less design complexity is
desirable. In the provided example (Figure 14), the overall site design
uses an achromatic scheme so that when colors are used in secondary
elements they will draw the attention of the viewer (in this case,
products that the vendor is seeking to sell are provided in full color,
while menu items and logos are muted grays). Achromatic schemes
may be helpful if secondary elements are complex and rich, but
without these secondary elements, the design itself would be visually
boring.
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Figure 14
Achromatic Schemes Use Only Black, White, and Grays

5.6. Choice and Use
Various tools are available to designers that provide color scheme
examples, such as the Adobe Color website or the Google Material
Palette Generator, and there are many different ways to create a color
scheme. For our purposes, however, I will offer two simple techniques
to create professional-looking color schemes that anyone can follow.
The first approach is to start with a single, dominant color that
matches your overall emotional objective for your product—blues
might be calming or sad, greens might be fresh or healthy, yellows
might be fun or playful, reds might be outrageous or dangerous, etc.
However, this decision might already have been made for you via
institutional branding or logo decisions. Once you have this color, plug
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the color into a color scheming tool such as Adobe Color, and use the
provided radio buttons to switch between color scheme types (e.g.,
analogous, monochromatic, complementary). If you want a simpler,
safer design, go with a monochromatic type, and drag the circles on
the color wheel to various saturation levels to give you sufficient
variation in the five-color scheme. If you want something more
interesting, try the complementary or analogous type. In the case of
analogous, you can drag the circles around the color wheel to
increase color variation, but the colors generally should not extend
more than one-third (120-degrees) the circumference of the circle,
lest the variation be too great. In the example image (Figure 15), I
started with the Twitter logo blue (#00bbff) and found that an orange
hue (#ff8400) might serve as a nice accent (complementary) color.

Figure 15
Choosing Different Color Scheme Types in Adobe Color From a Single Dominant Color

The second approach is to choose a picture or painting that you enjoy
(preferably of a natural setting) that you feel exemplifies the
emotional state you want to create with your design. Then, upload the
image to Adobe Color via the “Extract from an image” feature. This
will attempt to identify the dominant colors in the picture and to
situate them in relation to one another in a harmonious manner. Once
imported, you can click back on the color wheel to see where the
colors fall and to switch between color scheme types. In the provided
example (Figure 16), the image of trees in autumn generated an
analogous color scheme of oranges, yellows, greens, and burnt
orange.
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Figure 16
Extracting a Color Scheme in Adobe Color From an Existing Image

Once you have created a color scheme you are happy with, you can
import the color scheme into other applications in a variety of ways.
The simplest and most versatile method, however, is to simply take a
screenshot and place it into your authoring tool or to manually
transfer the hexadecimal codes.

6. Conclusion
This chapter has provided an overview of (a) the physics and technical
notations for color, (b) scholarly literature on the relationships
between color, emotion, and learning, (c) some guiding considerations
on how to use color in UX design, and (d) concrete information on
effectively using color schemes to improve harmony and contrast in
designs. Some major takeaways for designers should include the
following:
Choose dominant colors that will influence emotions aligning
with your intended design goals.
Use colors in ways that are intentional (e.g., accentuating
important content) and natural or appropriate by drawing upon
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users’ prior experiences.
Ensure that color contrast is sufficient and that color is used
strategically to allow learners to clearly and readily identify
important content and follow intended user pathways.
Choose a color scheme that counterbalances the complexity of
your content (complex content requires a simpler color scheme,
while simpler content can use a more complex color scheme).
Use whitespace and white, black, or gray text to increase
contrast and to balance color-use.
By following these suggestions, UX and LX designers can create
designs that increase motivation and persistence by making user
experiences more pleasing, more intentional, and less frustrating.
From a research perspective, much work is still needed to help
designers better understand issues of contextual color-use,
differential affective influences on learners, and interactions between
various colors as well as between color, content, and objectives.
Because effective color-use in UX design is best described as craft (or
synergy between science and art) and because learning contexts vary
so greatly, it is reasonable that the most important research in this
area moving forward will focus on applied, focused uses of color
through iterative design cases and continual improvement. Though
UX designers might not have the same obsession with color that
Monet expressed, hopefully our obsession for learning will help us to
more fully recognize that color is an important aspect of the learner’s
experience that should be better understood and more skillfully
applied.
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Multimedia Design
Sai Satish Gattupalli, M.F., J.M., & Torrey Trust

Teens today spend, on average, 8.5 hours every day consuming
media (Common Sense Media, 2021). Similarly, “American adults
spend over 11 hours per day listening to, watching, reading or
generally interacting with media” (The Nielsen Company, 2018, para.
2).

In a world where media consumption is deeply embedded into
nearly everyone’s life, it is essential that your website offer the
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same type of multimodal learning experience. Multimedia can
increase the appeal of the website, while also offering visitors
different ways to connect with and explore the site content.
Consider the Universal Design for Learning (UDL) framework, which
was designed to “improve and optimize teaching and learning for all
people based on scientific insights into how humans learn” (CAST,
Inc., 2019, para. 1). One of the three UDL principles is Multiple
Means of Representation - providing learners with more than one way
to access and learn content. When you provide videos, podcasts, or
images that present the text-based information in a multimodal
format, you are giving the viewer a choice in deciding how to explore
the information.

In Chapter 3 you will find tips, resources, and tools for using media
designed by others on your website without infringing on copyright.
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This chapter focuses on how you can create your own multimedia to
enrich the way you present and communicate the information on your
site.
The chapter will start with a brief overview of design techniques and
then will be followed by a showcase of digital tools for creating audio,
video, and images for your site.

Multimedia Design
It's easy to design digital media with the tools available today,
however, designing digital media that positively impacts learning (aka
whether visitors acquire information from your site) is quite
challenging. This section will provide some tips and strategies for
creating effective multimedia.
First and foremost, design with your audience in mind (see:
Getting a scientific message across means taking human nature into
account).
Who is the audience of your website?
What do they know already about your website topic?
What type of words or phrases do you use when speaking with
typical audience members about this topic (use this same
language in your audio/video products)?
Consider any myths or misconceptions your audience might have
about your topic and make sure to debunk those first! Researchers
have found that students are less likely to watch a science video when
they think they already know the information from the video, even if
their knowledge is incorrect (Helll-ooo! Watching Videos Does Not
Necessarily Lead to Learning).
Here are some more tips to creating more impactful media products:
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Make sure the multimedia is accessible - Add accurate
closed captions to videos, include a transcript for audio
recordings/podcasts, and use ALT text to describe an image.
Hook your audience - Use humor, surprise, inquiry, a short
vignette (Need more ideas? Read 12 Presentation Hooks Used
By the Best TED Presenters).
Be creative and social - Break away from the traditional mold
of educational multimedia (aka lecture videos, documentaries,
infographics full of far too much information).
Use visuals - quite simply, visuals are more memorable than
words. The less on-screen text, the better. After watching this
short TED Talk, what do you remember most? The visuals or
the words? (Research article: Pictures Move People More than
Words Emotional images can change people's behavior, while
similarly charged words do not).
Read What Makes Good Design? Basic Elements and
Principles to learn basic visual design techniques.
Use media in an ethical and legal manner - If you upload a
video to YouTube with a popular song as the background music,
it will be flagged and taken down. Use your own original art or
Creative Commons works with attribution (explore Chapter 3
for more information about finding and using Creative
Commons media).

Heath & Heath's Made to Stick Principles
The following principles provide a valuable guide to designing
captivating media:
Simple - Don't overwhelm with facts, ideas, or information. Use
the rule of 3 (what 3 things do you want the audience to take
away from your media?).
Unexpected - Information and ideas that are shocking are
more memorable. How can you surprise the audience with your
media?
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Concrete - Don't use abstract terms or complex jargon. Present
information in a way that is relevant to the audience.
Credible - Why should the audience believe you? Credibility
can come in many forms (education degree, profession,
personal experience).
Emotion - Simply increasing an individual’s heart rate results
in a higher likelihood of sharing a video. "Virality is partially
driven by physiological arousal. Content that evokes higharousal positive (awe) or negative (anger or anxiety) emotions
is more viral. Content that evokes low-arousal, or deactivating,
emotions (e.g., sadness) is less viral" (Berger & Milkman, 2011,
p. 1).
Story - When you tell a story, people not only listen/watch,
parts of their brain activate as if they are experiencing the
story themselves (read: The Science of Storytelling: What
Listening to a Story Does to Our Brains). Thus, storytelling is an
incredibly powerful and impactful teaching tool (learn more:
Stories are better than lectures at teaching us about health).

Multimedia Learning Principles
Through extensive research based on how multimedia impacted
college students' learning, Richard Mayer (2009) developed 12
guiding principles for the design of multimedia. The following bullet
point list is a synthesis of the key points from these principles:
Don’t Distract - Get rid of extraneous information, stories,
images, sounds, or content (while it might be fun to tell the
story of the time you were white water rafting and saw a
beautiful Scarlet Macaw, if this story is not relevant to your
video about dividing fractions, then leave it out!).
Direct Attention - Use text, arrows, bolding, sound effects, or
other tools to signal key information (notice how the bolded
text stands out and draws your attention!).
Use Visuals with Narration - The combination of spoken
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words and pictures or videos is stronger than words by
themselves.
Keep it Together - In an image, keep your graphics and their
labels as close as reasonably possible to one another. In a
video, make sure the visuals match the narration.
Chunk it - Break up podcasts, audio files, and videos into
shorter media files.
Keep in Conversational - Speak in a conversational tone.
Don’t use technical or academic jargon. Use plain, easy-tounderstand language (review the Writing for the Web chapter
for tips on how you can improve your audio or video scripts). If
you do plan on using acronyms or uncommon words in your
audio or video, make sure to define them early on.
For an in-depth overview of the 12 principles, visit Davis and
Norman’s (2016) Principles of Multimedia Learning article. Keeping
these principles in mind can help you create media that enriches,
rather than detracts from, the content on your site.

Designing Audio for Your Website
Audio is one of the most common ways to keep your audience
engaged. In classrooms, learners listen to their peers and the
instructor. However, websites tend to overemphasize text and
underemphasize the power of audio. One of the major advantages to
using audio over text is the use of high pitches, low pitches, tones and
inflection to match the context of the subject matter being taught.
People tend to process auditory information quicker and easier than
similar information in a text-based medium (to learn more, explore
The Use of Audio in eLearning site). Your audio could be an
instructional clip, an interview, a narrated story, or a podcast. In this
section, we’ll cover the basics of how to record audio using the free
online tools and software programs: Vocaroo, Online-Voice-Recorder,
and Audacity.
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Design Tip
Before you proceed to record your audio file, make sure you are in a
quiet location without any background noise. Use an external
microphone, such as a lavelier or shotgun mic, rather than your
computer or smartphone mic to capture higher quality sound. Pay
attention to any external noises such as a person walking by, a door
shutting, a car starting - as these can ruin an audio file.

Tool #1: Vocaroo
Vocaroo is a popular and intuitive flash-based tool for recording audio
clips. Simply visit Vocaroo.com and select “Click to Record” to start
creating an audio file.

That’s it! You can now download your recording as an mp3 or WAV
file or share it via a link. If you’d like to re-record, you may do so.
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Tool #2: Online-Voice-Recorder
Similar to Vocaroo, this is an online voice recording tool that is
convenient and simple to use. You can also use this site to trim your
recording and save a particular section. Head to Online-VoiceRecorder, click the red microphone icon, and start your recording.

You can now Save the file in an mp3 format.

Tool #3: Audacity
Audacity is a more complex multi-track audio recorder and editor. It is
also a free and open-source software. Unlike other online tools,
Audacity is a program that needs to be downloaded to your computer
before you can record your audio files. Visit the Audacity Download
page and to get the software for your computer. While the basic
recording function is virtually identical to that of the prior two
resources, it’s highly suggested that you take some time to familiarize
yourself with the more advanced features (such as noise cancellation)
if you choose to use Audacity.
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Using Audacity, you can export your recording in various formats,
including mp3, WAV, and OGG. Here is how you Export your file.
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Audio Design Tips and Tricks
Do a test run by recording a short bit of audio and playing it
back to hear how it sounds.
Anticipate the sounds you might hear during the recording
(e.g., a person walking by your recording area or a plane flying
overhead) and make adjustments to avoid noise.
Stay close to the microphone, but not too close (hold the mic
about 6 inches or a fist-width away from your mouth).
Avoid typing on the keyboard while recording to avoid
distracting keystroke noises.
Don’t breathe heavily into the mic.

Designing Video for your Website
A properly made video will mesmerize your website visitors. Videos
have become the most popular instructional tool and being able to
provide your learners with videos like Khan Academy or Ted-Ed will
make your website more engaging and appealing. Designing a video
can be time consuming, and sometimes frustrating, but with the right
tools and design skills, anyone can make captivating videos. The
following section features two web-based design tools for creating
videos: Adobe Spark and Screencastify. You can also use software,
such as iMovie, Adobe Premiere, Shotcut (free), Windows Video
Editor, or Final Cut Pro, to edit together professional quality videos.

Tool #1: Adobe Spark (now Adobe Express)
Adobe Spark is a free online tool that lets you create beautiful videos,
images, and web pages. This video-making software allows you to
create compelling video stories quickly by piecing together slides of
visuals with audio. Here is how you use it:
1. Visit Adobe Spark and create a free account.
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2. After you sign in, click the blue “+” icon at the very top of the
screen and select “Video”.
3. You will now be prompted to pick a story template or you may
start from scratch.
4. Pick any template and you will be brought into the video editing
mode.
This editing mode is comprised of three elements - the timeline area
(at the bottom), the styling area (on the right), and the main video
content area (in the center).

Add new slides to the video by clicking the “+” icon in the timeline
area.
Change the layout of each slide from the styling panel and control
how long each slide plays from the timeline panel.
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Add Creative Commons music, images, and videos to your movie from
the styling area.
You can also upload your own images (jpeg and png), videos (mp4 and
mov), and background audio (mp3). When your video is complete, you
can download the video in mp4 format or share it via a URL. Any time
you’d like to make modifications to your video, you can login to Adobe
Spark on a computer or smart device and make changes and
download the new video instantly.

Tool #2: Screencastify
Screencastify is a screen recording extension for Google Chrome. It is
a light-weight, powerful, and easy-to-use screen recorder. However, it
has a time limit of 10 minutes per recording with the free account.
To get started, you must download and install the Screencastify
extension on your Chrome Browser. Click on the Screencastify icon in
the top right corner of your web browser and sign in with your Google
account.

This will let you save all of your screen capture footage to your Google
Drive. Now, click the icon again and you can start recording the
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action.

All your recording sessions will automatically be saved on your Google
Drive account.

The EdTech Books User Guide

108

Video Design Tips and Tricks
Keep your videos short (e.g., 3-5 minutes).
Use the design principles discussed earlier in this chapter to
capture and maintain the attention of your learners as they
watch your videos.
Don’t use any copyrighted images or visuals in your video.
Search for Creative Commons resources from Pixabay, Videezy,
Unsplash, and more (e.g., Guide to Finding Media for
Classroom Projects). Make sure to give proper attribution when
using any Creative Commons licensed materials (review
Chapter 3).
Use the YouTube Audio Library or Unminus to find Creative
Commons background music. Give attribution as needed.
If you include background music, make sure it’s not too loud,
otherwise, it’ll distract the viewer.

Designing Images For Your Website
Research has shown that images are more powerful and
memorable than text (see: Pictures Move People More than Words
Emotional images can change people's behavior, while similarly
charged words do not).
Every page on your website should have at least one image to
complement and enrich the text (if you need help figuring out how to
select or design an image that complements the text, visit Chapter 3).
Before exploring this section, read What Makes Good Design?
Basic Elements and Principles to learn basic visual design
techniques. In the following section, you will learn about 3 digital
tools for creating images: Pablo, Canva, and Adobe Spark.
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Tool #1: Pablo
Pablo is a commonly used tool for creating quick web banners with
custom text.
To get started:
1.
2.
3.
4.

Visit the Pablo website.
Select an image.
Double click on the image to add text.
When you are done, click on Share & Download button at the
bottom of the screen to download the picture in a jpeg format.

Tool #2: Canva
Canva is a free website for designing professional quality images and
graphics. Canva offers pre-made templates that you can customize,
such as posters, social media graphics, infographics, and flyers. When
you get to the website it will ask you to sign up with your email. Once
you sign in, it will ask you invite friends to see your work but you can
skip over that part and get started with the process of creating
custom images and graphics. Click on any template, then double-click
on any text/image to edit. When you are done creating your
masterpiece, you can download it as a jpg, png, or pdf.
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Tool #3: Adobe Spark
Spark (covered in the video section) is similar to Canva in regards to
the creation of images. It offers pre-made templates that you can
adjust and customize yourself. You can easily integrate Creative
Commons and Public Domain images into your graphic. To get
started, click the “+” sign and select Graphic. Select a template to use
or start from scratch. When you are done, you can download the
image to your desktop or share it via a URL.
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Image Design Tips and Tricks
Use copyright-free pictures or Creative Commons images with
attribution (review the Guide to Finding Media for Classroom
Projects).
Don’t include visuals on your website just for the sake of mixing
things up. Select visuals that complement and enrich your text
(see Chapter 3: Finding Images that Complement Your Text).
Limit how many words you put on an image. The power of
images comes from the visual appeal.

Chapter Overview Video
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Additional Design Tools and Resources
Creative Commons & Royalty Free Media
How to Give Attribution - Creative Commons
The Educator’s Guide to Copyright, Fair Use, and
Creative Commons
Guide to Finding Media for Classroom Projects
Spreadsheet of OERs
Alternatives to Google Image Search - Chart
Sources of Free Sound Effects and Music for Multimedia
Projects
Audio: YouTube Audio Library & Unminus & Dig
CCMixer
Video: Videezy & Pixabay Videos & Pexels & Vimeo
Creative Commons & Videvo
Audio
Beautiful Audio Editor
Anchor & Synth - podcasting
Simple audio & video editing tools
Sound Trap - music making
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Twisted Wave - audio editor
Clyp.it (audio recording & sharing)
Record MP3 Online
How to Podcast for Free
Video
Powtoon animation tool
Wevideo
Clips (for Apple) & Quik (for Android)
Headliner
Shotcut - free open source video editor
11 Mobile Video Creation Apps
Video Creation & Editing Apps
Tips for Shooting and Editing Videos
The Best Free Video Editors for Windows
iPad/iPhone Video Editors & Tools
Screenrecording Tools
Stop Motion Studio - capture a series of photos and turn
them into an animated video
Snapchat - capture photos and videos and embed
Bitmojis, text, and other icons
Images
KQED Design Courses (designing infographics, memes,
etc...)
Visualize Learning with Photo Challenges
Pixlr & Sumo Paint (similar to Photoshop)
Inkscape (professional vector editor)
Tuxpi
Comic Strip Creators
Make a Meme
Imgflip - GIFs and Memes
Visme - graphic design
9 Web Tools for Creating Infographics
Cycloramic & Google Street View app - capture 360
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degree photos
Thinglink & Google Drawings - interactive images
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Basic Features
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Book Covers

The Book Cover Tutorial and Template can be used to create book
covers for textbooks. Alternatively, if you want to create your own
book cover from scratch, the image should have dimensions
equivalent to 5.5 x 8.5 and be less than 1MB in size.
To create a book cover using our template, begin by opening the
Google Slides template. Upon clicking the link, you will open (and
copy to your own Google Drive) a document that has been
preconfigured to the correct book cover dimensions.
Follow the steps in the tutorial, which are also articulated below:
1.
2.
3.
4.
5.
6.
7.
8.

Add text
Change fonts
Choose a color scheme
Select images
Select vector graphics
Select icons
Put it all together
Save your cover

The final step is to save the book cover design as a JPEG image. After
saving the image to your computer, navigate within EdTech Books to
the textbook that you want to add the book cover to. Select the
Settings option in the top-right drop-down menu.
Scroll down and upload your new image in the provided area. Your
new book cover is now automatically applied to the textbook!
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Callouts

Callouts are emphasized boxes of content that you can insert into your
chapter to accentuate small blocks of information, such as learning
objectives, key takeaways, or a vignette.
To insert a callout using the inline editor, place your cursor where you
would like it placed and go to Insert... > Callout Box. The default style
will look like this:

Callout Box
This is what the default style looks like.
If you would like to change the style of your callout box after it has
been inserted, select the DIV layer of the Callout Box and choose a
style.

Alternate Styles
There are a number of alternate callout styles built into the system.
You can apply a custom callout style while inserting the callout by
selecting the name of the alternate style in the "Custom Class" box. A
formatted example of each follows.
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Alternate Style "Positive"
Select Positive as the custom class.

Alternate Style "Negative"
Select Negative as the custom class.

Alternate Style "Objectives"
Select Objectives as the custom class.

Alternate Style "Exercises"
Select Exercises as the custom class.

Alternate Style "Information"
Select Information as the custom class.

Color Classes
Alternatively, you can also use color classes to modify the callout or
any other heading with the Text Color and Background Color options
in the Inline Editor. Here's an example:
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Heading with the "Light" Text Color and "Primary"
Background Color
The DIV layer here uses the "Light" text color and the "Dark"
background color.

Custom Formats via CSS
You can also modify the formatting of callout classes across your
entire book. In the example below, an additional class was assigned to
the callout of "callout-example," and then the following custom CSS
was added to the book by going to Advanced > Custom CSS:
#chapter-container div.callout-example { backgroundcolor: white; }
#chapter-container div.callout-example h3 {
background-color: pink; }

Custom Colors via CSS Override
Change the custom CSS for the book.
Alternatively, you can also override the look of all callouts in your
book by applying a similar custom style to the entire callout class,
such as the following:
#chapter-container div.callout { background-color:
white; }
#chapter-container div.callout h3 { background-color:
pink; }
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Custom Formats via the Style Attribute
As with any element, you can apply custom formatting to a single
callout by editing its "style" attribute in the HTML directly, but this
will not propagate to other callouts. An example of doing this to
increase the size of the callout's text would be as follows:
style="font-size: 1.4em;"

Example Style Editing
This callout's "style" tag was changed.

HTML Structure and Headings
Callouts are designed to start with the H3 class as the highest
heading (do not use H1 or H2 tags in your callout).
If you include a H3 element as the first element inside the callout, it
will be properly formatted as the callout's title (with the top borders
rounded and with no spacing at the top). If you wish to include
multiple H3 elements inside a single callout, you can fix the rounded
corners of subsequent H3 elements by adding the "no-border-radius"
class to them.
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Example H3
Example content goes here.

Example of H3 with "no-border-radius" class
Example content goes here.
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Footnotes

There currently is no automated footnotes management feature.
However, you can manually create footnotes by doing the following:
1. Create a heading at the end of your chapter called Footnotes
and apply the "Heading 2" style to it.
2. Create a numbered list of any footnotes you'd like to include.
(Note that you can change the numbering style to use letters,
numbers, or Roman numerals from the dropdown.
3. In your text, write the letter or number that corresponds to the
desired footnote and apply the superscript format to it by
highlighting it and clicking Format > Superscript.
Here is an example:
Technology integration models are common in
educational technology.a However, there is no standard
model that all researchers and practitioners use.b
And the footnotes could be shown like this:

Footnotes
1. Educational technology is a loosely-defined field.
2. Some common models include the following: TPACK, SAMR,
etc.
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Images

Media Library
Each book has its own media library that all chapters in the book
share. To upload images to the book's media library, navigate to the
book's home page and click on the media library button at the top of
the page.

Media Library Icon

When uploading images, be sure that each desired image has a unique
name. Uploading an image with the same name as a previously
uploaded image will give the new image a new name. If you would like
to update an image across an entire book, simply delete the image
from the media library first and then upload the updated version with
the same name.
Once an image is in the media library, it can be embedded in any
chapter by editing the chapter, clicking on the "Insert/edit image"
button, and selecting the image's name from the dropdown menu.
Alternatively, if an image is already hosted on another website on the
internet, a chapter author can hotlink to it by pasting the image's URL
directly into the image embed window. When saving the chapter, if
the system detects that the image is hosted on another site, it will
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attempt to automatically download it and save it on EdTech Books.

Text Wrapping
Because all books created on this site are intended to be mobile-first,
and because mobile devices have very small screens, most images you
include in your book should fill the entire width. Otherwise, you may
have instances where only a couple of words are shown on a single
line of text.
However, there might be legitimate times when you have a small
image that you do not want to take up the full width of the page (as
with the media library icon above). Text wrapping in HTML-speak is
done with what is called "floating." Programmatically, we accomplish
this by using some fancy styling that allows the page to change
floating options depending upon the size of the page (e.g., floating the
image if the width is large [as with a laptop's web browser] while
removing the float if it is small [as with a phone's web browser]).

The image float drop-down menu
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To do this in the editor, simply right-click on the image, choose
"Image...," and select one of the custom classes from the provided
drop-down menu. If you want your image to be on the left of the page
and for the text to wrap around it on the right, then choose one of the
"Float Left" options. If you want your image to be on the right, then
choose one of the "Float Right" options.
Note that the preview in the editor of the text wrapping may not be
accurate, so you will want to save the chapter to see how it actually
looks.

Text Wrapping with Captions
If your image has a caption, then floating becomes even more
complicated, because the float must not just apply to the image itself
but also to the caption and to their parent element (in HTML-speak,
their "figure" element).

If the image has a caption, apply the float setting to the figure, not the image

This means that if you follow the process above with your image,
which applies a float just to the image, then the caption may be on its
own—centered on the page or disjointed from the image it's supposed
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to describe.
To correct this, simply right-click on any image with a caption and
choose "Figure...". Then, choose the desired float option from this
drop-down menu instead. Doing so will apply the float to the entire
figure (which contains both the image and the caption), as in the
example in this section.
You should not apply a float to both an image and its figure at the
same time. When you apply a float to the figure (as described here),
then it overrides the original float setting on the image, and viceversa. So, if your image has a caption, simply set the float in the
"Figure..." dialog and not the "Image..." dialog.

Two Floated Images Side-by-Side
You can place two floated images side-by-side by using the process
above, applying a "Float Left" to the first and a "Float Right" to the
second. This will show the two images side-by-side on larger screens
but will reorganize them to a stacked view on smaller screens. To
make this easier, you can also insert two placeholder images by
clicking "Tools > HTML Snippets > Side-by-side Images" and then
right-clicking each, choosing "Image...," and replacing it with the
desired image.
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The first of the side-by-side images.
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The second of the side-by-side images.

You can test the behavior of the two images above by resizing your
screen or by viewing the page on different devices.

Avoiding Float Overlaps with Clear Fixes
One final difficulty with floats is that it is not always obvious to the
browser what text and other elements should be wrapped around the
image and what should not. This can lead to some ugly layouts if you
have multiple floated images near one another or don't have enough
text following a floated image.
To remedy this, you can insert an invisible element anywhere on the
page to tell the HTML to stop the wrapping and to put any new
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content below it on a fresh, new line. To do this in the editor, simply
place your cursor where you want the wrapping to stop and choose
"Tools > Clear Fix." This will insert the dashed, green element on your
screen below to let you know that all wrapping will stop at that point.

The green indicator is only visible to you in the editor and will not be
shown to your reader. This allows you to start a new line of text or
even a new floated image on a new line, separate from any previous
wrapping introduced by earlier images.

The EdTech Books User Guide

130

Microsoft Word Conversion

By default, all chapters are available for download as Microsoft Word
documents. To download a chapter, navigate to the chapter and
append "/ms_word" to the end of the URL.
For example, the URL for this chapter's Microsoft Word download is
https://edtechbooks.org/userguide/ms_word/ms_word
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PDF Conversion

By default, each chapter in your book and the book itself will build
two different PDF files for download: mobile and printable. Mobile
PDFs are optimized for tablet viewing, while printable PDFs are
optimized for printing on U.S. letter-sized paper.
To make sure that PDFs are enabled on your chapter, while editing
your chapter, click on Formatting and ensure that the PDF Rendering
option is enabled. A similar option is available when editing the book's
main page.
Once PDFs are enabled for your book or chapter, the download link
will appear in the dropdown menu. However, PDFs must be built by
the server in the background and may not be instantly available.
Chapter PDFs generally take several minutes to build (depending on
server load), and book PDFs may take a few days. This process can be
expedited by the administrator upon request if needed.
Additionally, building PDFs is a difficult, highly-technical task, and
authors should be aware that the PDFs generated by the automated
system might not look exactly like the web version. If there are major
issues, please contact a site administrator to see if improvements to
the PDF building algorithm can be made. Otherwise, if you need your
PDF to look a particular way, you may also build the PDF yourself in
another program, host it on another site (like Google Drive), and
include the link as an alternative PDF download link.
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Tooltips

Tooltips allow you to provide hover text, like a glossary. Hover on this
text to see an example.
To create Tooltips, select some text and use the Inline Editor to
click Insert... > Tooltip .
In the editor ribbon, update the Tooltip text with the desired pop-up
text. Many elements, such as links, additionally have a tooltip option
that can be enabled. Click on the Tooltip button to enable or disable
the pop-up.

The tooltip editor in the inline editor ribbon.
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Videos

Any videos you wish to include in the chapters of your book must be
embedded. To embed a YouTube or Vimeo video, select the "Tools"
option in the WYSIWIG editor. Under tools, you can select either a
Youtube or Vimeo video. If your video is from Youtube, enter either
the Youtube ID or the URL and the resolution type. If your video is
from Vimeo, enter the Vimeo ID. Press submit, and your video will be

The EdTech Books User Guide

134

embedded in the chapter of your book.
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WYSIWYG Editor

This site uses the Tiny WYSIWYG editor [https://www.tiny.cloud/] to
assist authors in formatting chapter contents.
Alternatively, authors also have the option to edit their chapter's
HTML directly by choosing View > Source code within the Tiny editor.
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Advanced Features
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Analytics

See the page on Google Analytics also.

Cost Savings
Estimating cost savings is a difficult task with open textbooks and
other publications. Below is a snapshot of the algorithm we use to
predict cost savings.

Chapter Cost
Cost per page (default = $0.10) * Words in the
chapter / Words per page (default = 500)

Chapter Savings
Chapter cost * (Predicted read count + (Untracked
views * Reading likelihood) + PDF downloads)

Book Cost
Σ(Chapter cost)

Book Savings
(Book cost * PDF downloads) + Σ(Chapter savings)
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API

The Reading API for this site allows users and apps to access book
and chapter objects in JSON format. The url for the Read API is the
site's base url plus "api.php" (e.g., https://edtechbooks.org/api.php).
Two types of objects may be requested via the Read API: (a) a book or
(b) a chapter. Book calls require the book variable, which will look up
the book based upon the unique "short name" provided. Chapter calls
require both the book variable and the chapter variable, which will
look up the chapter based upon the unique "short name" for each.

Usage
The API may be used to display content in your own site or app
provided that you include proper attribution for the content and the
hosting site. This can easily be done by displaying the suggested
citation for the book or chapter.

Data Structure
The platform uses three main data object types: authors, books, and
chapters. Other objects are also sometimes used, such as glossary
terms.
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Variables
Variable

Type

Status Default

Description

action

string optional read

Specify the action to be performed. If no action is specified, the API will attempt to return
a book or chapter.

book

string optional -

The short name of the book, which is the path of the book's base or cover url. For example:
http://edtechbooks.org/qualitativeinquiry

chapter

string optional -

The short name of the chapter, which is the last part of the chapter's url. For example:
http://edtechbooks.org/qualitativeinquiry/storyanalysis

glossary_term

string optional -

The anchor name of the glossary term.

glossary_term_id int

optional -

The term_id of the glossary term.

term

string optional -

Specify a search term for some actions.

limit

integer optional 10

Specify a limit. Maximum: 200

offset

integer optional 0

Specify an offset for pagination purposes.

key

string unused

The Reading API currently does not require a key.

-

Actions
Options for the action variable include the following:
read (default; requires book; also uses chapter)
analytics(requires book; also uses chapter)
search_authors (requires term)
search_books (uses term, but returns full list of books if no term
is provided)

Examples
To request reference information for all books in the site, the API call
would be:
https://edtechbooks.org/api.php?action=search_books&o
ffset=0&limit=200
To request the book object for https://edtechbooks.org/k12handbook,
the API call would be:
https://edtechbooks.org/api.php?book=k12handbook
To request the chapter object for
https://edtechbooks.org/k12handbook/connectivism, the API call

The EdTech Books User Guide

140

would be:
https://edtechbooks.org/api.php?book=k12handbook&chap
ter=connectivism
To request the glossary term "constructivism" in
https://edtechbooks.org/k12handbook, the API call would be:
https://edtechbooks.org/api.php?book=k12handbook&glos
sary_term=constructivism
To search for books with the term "education" in the title, the API call
would be:
https://edtechbooks.org/api.php?action=search_books&t
erm=education
To request the analytics for the chapter
https://edtechbooks.org/k12handbook/connectivism, the API call
would be:
https://edtechbooks.org/api.php?book=k12handbook&chap
ter=connectivism&action=analytics
To search for an author with the name "Royce," the API call would be:
https://edtechbooks.org/api.php?action=search_authors
&term=royce

App Structure Example
An example of a simple app that accessed books on this site might
follow this structure:
1. A home page that called
https://edtechbooks.org/api.php?action=search_bo
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oks to return all available books (with short names). You can
use the offset and limit variables to iterate through the entire
list.
2. If a book is selected,
https://edtechbooks.org/api.php?book=[book_short
_name_here] is called with the appropriate short name.
3. If a chapter is selected,
https://edtechbooks.org/api.php?book=[book_short
_name_here]&chapter=[chapter_short_name_here] is
called with the appropriate short name.
An example of an app that could download the entire available
database might follow this structure:
1. A home page that called
https://edtechbooks.org/api.php?action=search_bo
oks to return all available books (with short names). You can
use the offset and limit variables to iterate through the entire
list.
2. Download each book by accessing its short name at
https://edtechbooks.org/api.php?book=[book_short
_name_here]
3. Download each chapter by iterating through the chapter briefs
for each book returned in Step 2 via
https://edtechbooks.org/api.php?book=[book_short
_name_here]&chapter=[chapter_short_name_here]

Authentication
The API currently does not require a key, but that could change as the
site and its services develop. For more information on future plans for
the API or to request a key, please contact the site administrator.
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Artifacts

Artifacts are external resources (links) that you can embed within a
chapter. You can access the "Artifact Links" field in the chapter
"Settings." Enter a new link on each line of the "Artifact Links" field,
and the chapter will attempt to embed the resource.

Access Requirements
To be properly embedded, any linked resources must be made
available to the public on their original site and must also allow for
embedding.

Headings
You can include headings between artifacts by including a line of plain
text before or after links. Here's an example that would place a
heading that says "Video" before an embedded video:
Video
https://youtube.com...

Forced Embedding
Most links will be properly embedded automatically. However, you
can also force a link to be embedded a particular way by including the
desired type code in the link line, separated by a vertical bar
character. (The vertical bar key is found below the backspace key on
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most keyboards.) Table 1 provides a list of available artifact types.
Here's an example that would force a zip file in Google Drive to be
embedded as an Articulate Storyline element:
storyline|http://...
Table 1
Available Embeddable Artifact Types
Type

Code

Description

Articulate
Storyline

storyline

A public zip file of a storyline
hosted in Google Drive.

Box Folder

box

A public folder hosted in Box.

Google Doc

gdoc

A public Google word processing
document.

Google Drive File

gdrive

A public file hosted in Google
Drive (e.g., PDF).

Google Drive
Folder

gdrive-folder A public folder hosted in Google
Drive.

Google Sheet

gsheet

A public Google spreadsheet.

Google Slide

gslide

A public Google slideshow.

Vimeo Video

vimeo

A public video on Vimeo.

YouTube Video

youtube

A public video on YouTube.

Web Link

link

A simple link to an external
resource. (This is the default.)

Link Text
Each embedded resource will also have a link to view the resource in
a new window. To adjust the visible text of this link, simply add your
text to the artifact line separated by a vertical bar character.
Click here to see it | https://youtube.com...
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storyline | Open the Storyline |
https://drive.google.com...

Placement
By default, artifacts are shown before the chapter contents. You can
change this in the chapter's settings by adjusting the Artifact
Placement setting.
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Canvas Embedding

The following video explains how to embed your textbook into Canvas
so that your students can access its contents within the context of
your course from the main course navigation.
Essentially, you simply use the LTI-enabled Redirect App within the
Canvas interface to create a course navigation link to your book's
cover page.
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Watch on YouTube https://edtechbooks.org/-uzE

Alternatively, you can also use the Simplified View feature to embed a
single chapter into a Canvas module.
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Checking Grammar and
Spelling

EdTech Books does not have a built-in spell- or grammar-checker.
Instead, you should either do most of this checking as you write your
content on another platform before pasting it into the site (such as
Microsoft Word or Google Docs) or use a browser extension such as
Grammarly. If you encounter errors in your work after it has been
uploaded to EdTech Books, you can use either the WYSIWYG Editor or
the inline editing function in the top right corner of your screen. For
more details on editing chapters, see Editing a Chapter.
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Code Snippets

Code snippets can be displayed on any chapter page by using the
"Code" option from the style dropdown.
# Here is an example block of code using the "Code"
style.
var x = 1;
x++;
console.log(x);
To add new lines to the same block of code, hold down Shift while
pressing enter to do a soft line break.
Currently, displaying HTML (or any language that uses brackets < >)
is not fully supported.

Inline Code
Inline codes like this can also be used by choosing the "Code (Inline)"
option from the style dropdown.
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CSS Customization

While editing the book's cover page, you can include custom CSS into
the Custom CSS field, and this will be applied to all chapters in the
book.
This is very powerful and can have undesired effects, because the CSS
is applied to the entire page (not just the chapter contents). For
instance, including a line like the following
body { color: pink; }
would make all text in the book pink, including the author bios and
other non-content elements.
To prevent CSS from changing site formatting unexpectedly, you can
limit your adjustments to only apply to content within the article tag
or the #chapter-container id as follows:
article h2 { color: pink; }
#chapter-container div.callout h3 { background-color:
#6fbada; }

Snippets
These are some snippets that can be adjusted to add elements in a
chapter or across an entire book.
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Banner Image
This snippet places an image above the main heading.
#chapter-container h1 {
background-image:
url("https://edtechbooks.org/images/logo.png");
background-repeat: no-repeat;
background-position: top right;
padding-top: 140px;
background-size: 100px;
}
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Flights or A/B Testing

Flights enable you to conduct A/B or comparative testing on your
chapter contents. A chapter flight is a temporary copy of your chapter
that your readers can be assigned to (either manually or
automatically) so that you can compare reader behaviors based upon
small adjustments to the chapter.
For instance, you might want to know whether the inclusion of a
particular diagram influences your readers' ability to answer a
practice quiz question correctly. To do this, you would simply (1) add
the diagram and practice quiz to your original chapter, (2) create a
flight (which copies the chapter), and then (3) edit the resulting flight
to remove the diagram. User behaviors for each of the versions will
then be tracked separately in the analytics section for each flight.

Manual Assignment
Each flight has its own unique URL and QR Code; the URL uses the
following pattern:
https://sitedomain/bookname/chaptername/flightnumber
You can manually send users to this flight by sharing it to an email
list, on your learning management system, and so forth, but general
readers will never be directed to the flight.
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Automatic Assignment
All readers who view the chapter will be randomly assigned to either
the original chapter or one of the flights.
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Google Analytics

In addition to the default analytics provided for each chapter, each
book author may also set up Google Analytics to track information
about page visits and users of the book.
To do this, perform the following steps:
1. Create a free user account at Google Analytics;
2. Create an Account and Property for your book;
3. Assign the Property with the URL of your book (e.g.,
https://edtechbooks.org/lidtfoundations);
4. In your Property settings, find your Tracking ID in the tracking
code (e.g., UA-XXXXXXXX-X);
5. Copy this Tracking ID, and paste it into the Google Analytics ID
field in your book's Settings.
After completing these steps, you should be able to access the Google
Analytics dashboard for your book and see any active users.
For further help setting up and using Google Analytics (i.e., steps 1-4),
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please consult the Google Analytics documentation for developers.
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Languages

Each book and chaper can be identified according to its language by
selecting the desired language from the Language > Content
Language dropdown menu while editing.

Once selected, the book will be listed with other books of the same
language on the "Browse Books by Language" page.
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Practice Quizzes

Practice quizzes can be created within a chapter by placing the cursor
where you would like the quiz question and selecting Tools > Practice
Quiz.
Enter some text for the question (e.g., "What is the zone of proximal
development?") along with a question ID (e.g., "zpd" or
"zone_proximal_development"). The question ID will be used in the
analytics so that you can track question responses.
Then, include up to two answer options, like this:
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Click "Submit." You will now see the question with the options in your
WYSIWYG editor. You can add more answer options at this point by
simply pressing enter after the last option and typing a new one, as
follows:

To identify correct answers to the quiz question, simply select the
correct option and make it bold as follows:
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Now, when you save the chapter, the system will format the question
appropriately like this:
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Simpliﬁed View

A simplified view of every textbook chapter is provided to any reader
by easily appending the word /simple to the end of any chapter URL.
The simplified view removes site navigation bars and only delivers the
chapter content on a plain, white background. This is useful for
improving user experiences and stripping away unnecessary
distractors.
You can try it by clicking the drop-down menu at the top right of this
chapter and choosing "Simple" (or by typing "/simple" at the end of
the chapter name in the address bar).

Screenshot of a simplified view embedded in Canvas

The EdTech Books User Guide

160

This feature is especially useful if you are embedding chapters into an
iframe and do not want readers clicking on navigation items in the
book.
For instance, if you are creating a series of course modules in Canvas
and want to embed a chapter into Canvas without allowing students to
click on other chapters in the textbook or to be confused by the
EdTech Books logo, you could simply provide a link to the simplified
view of the chapter as an External URL (in this case
https://edtechbooks.org/k12handbook/online_safety/simple).
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Synchronization

If you imported a chapter from one book to another, you have the
option of keeping the child chapter synchronized to its parent. This
means that if the original author of the parent chapter updates it, any
changes to the content will be synchronized to your imported chapter.
This is useful for boiler plate content or imported content that you do
not plan to remix.
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Add-on Services

We have carefully designed our site to provide the fullest functionality
possible to authors and readers without paying any fees. However, to
provide some features, we need to use external services that incur
additional costs for us. These services are optional and can be
requested by book authors by paying a small fee.
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Lifelike Text-to-Speech

To improve accessibility and usability of content, we use Amazon's
Polly neural network service to convert finished text to a lifelike
recording, which may be embedded and listened to on any chapter or
article page.
This is a one-time cost. However, if the content is updated, then the
fee will need to be paid again to update the recording to match the
new text.

Examples
Sampling
Methods of User Centered Design and Evaluation for Learning
Designers
Figure 1
Example of a Page with Text-to-Speech
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Cost
~$1 per chapter (per conversion); actual costs will be calculated
based on the number of characters

Disabling Text-to-Speech
If you would like to remove the text-to-speech file or prevent it from
showing on the chapter, delete the content of the "External Audio"
field in the chapter Settings. You can also replace the content of this
field with a link to another fully-qualified URL, if you have a different
recording you would like to use.

Voices
We use the voices provided by Amazon Translate. Not all Amazon
voices may be available at present. If you would like to request a
particular language or voice, please let us know.
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Translation

Demo

Watch on YouTube https://edtechbooks.org/-woVA

Cost
Because this feature uses an Amazon service to create an automated
translation of the text, we must pay a one-time fee for every initial
translation conducted. This is roughly equivalent to $1 per chapter.
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Feature List

EdTech Books provides various features to authors and readers. This
page provides an abbreviated list of all of these features.

Watch on YouTube https://edtechbooks.org/-GMC

Content Editing
Google Docs importer
Wikipedia article importer
Easy WYSIWYG editor (using TinyMCE)
Media library
LaTeX Equations
Easy image embedding
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Easy YouTube and Vimeo embedding
Easy H5P embedding
HTML source editing
CSS overrides for books and chapters
Easy chapter importing
Automatic citation generation
Multi-language support
Chapter synchronization

Formatting
Mobile-first, flexible design
Professional, minimalist aesthetic
PDF downloads of each book and chapter (mobile- and printfriendly formats)
MS Word downloads of each chapter
Simple view of any chapter
Automatic URL shortening

Navigation
Clean (short) URLs (e.g., https://edtechbooks.org/ux)
Automatic chapter side navigation of headings, images, and
tables
Item-level linking (e.g., each paragraph)
Automatic QR codes
Automatic book indices
Easy embedding into Canvas (and other LMSs)

Analytics
End-of-chapter quality surveys
Reading heat maps
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Advanced Features
A/B testing via Flights
Interactive quizzes and surveys
Chapter narrations
Cross-site embedding
Open Read API
Data analytics on users
Multi-site, cloud-based hosting
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Community Meeting 2021
Royce Kimmons

This presentation was delivered on December 9, 2021 as part of
our inaugural EdTechBooks.org Strategic Planning Meeting. In
this meeting, we explained the current state of the site and
provided the community with opportunities to give feedback, ask
questions, and shape priorities for the site's future.
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Deprecations
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Glossaries

Deprecation Notice
Glossaries are being deprecated in favor of Tooltips.
Please see the Tooltips documentation for more information.
Each book has a built-in glossary, which may be accessed from the
top-right dropdown on the cover page > Glossary.
These glossary terms may be accessed from any chapter, and if you
would like to make the full glossary visible to readers, you can enable
it under the book settings page with the Glossary setting.

Creating Glossary Terms
While on your glossary page, you can add new terms using the form at
the bottom of the page. Each glossary term requires a name, anchor
name, and description as follows:
Term
The human-readable name of the term (e.g., "Project-Based
Learning")
Definition
The descriptive text for the term. HTML markup is allowed.
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Editing Glossary Terms
For any term that is created, click the pencil icon next to it in order to
edit.

Creating Glossary Lists within Chapters
You can include an automatically updated list of glossary terms with
definitions in any chapter. This is useful if you would like to include a
list of key terms within a chapter that will be updated as glossary
definitions change.

An example of an automatically-created list of glossary definitions to be included in a chapter

To do this, edit the chapter, place the cursor where you would like the
list placed, and select Tools > Glossary Terms List.
In the Anchors field, type in a comma-separated list of anchors for the
book's glossary terms that you would like to have listed, and
click Submit.
If you would like to edit the included list later, you can change the
terms, delete them, or add new ones directly in the editor.
To update the text that appears in the chapter as glossary terms are
changed, simply edit and save the chapter again.
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Creating Glossary Pop-ups
You can create glossary pop-up elements within your chapter by
editing the chapter, placing your cursor where you want the pop-up,
and choosing Tools > Glossary Link.
Here is an example glossary pop-up: Example Term

Creating Non-Glossary Pop-Ups
You can also create pop-ups manually by editing the HTML directly,
like this one: Example Non-Glossary Pop-up
To do this, use the following code, replacing YOUR DEFINITION
HERE and YOUR TEXT HERE with your own.
YOUR TEXT HERE
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Book Authors

The EdTech Books User Guide

176

Royce Kimmons

Royce Kimmons is an Associate Professor of Instructional Psychology
and Technology at Brigham Young University where he studies digital
participation divides specifically in the realms of social media, open
education, and classroom technology use. He is also the founder of
EdTechBooks.org. More information about his work may be found at
http://roycekimmons.com, and you may also dialogue with him on
Twitter @roycekimmons.
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Julie Irvine

Julie is an undergraduate student at Brigham Young University. She is
majoring in editing and publishing and minoring in creative writing.
Julie has three years of editing experience and over five years of
writing experience. She loves editing, writing, and storytelling. Julie
has been an editor for EdTech Books for 1.5 years, and she has
enjoyed working on open resource textbooks, writing research
articles, and bringing the vision of EdTech Books to university
students. If you'd like to reach out to Julie about editing or writing
opportunities, she can be reached by email or through her LinkedIn
profile.
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